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COPYRIGHT NOTICE

The Learning Labs, Inc. (“TLL")
All rights reserved, 2008
Reproduction in any form without permission is prohibited.

Disclaimer

Information in this document is subject to change without notice and does not represent a
commitment on the part of TLL.

TLL provides this document as is, without warranty of any kind, expressed or implied,
including, but not limited to, the particular purpose. TLL may make improvements and/or
changes in this manual or in the products(s) and/or the program(s) described in this manual at
any time.

Information in this manual is intended to be accurate and reliable. However, TLL assumes no
responsibility for its use, or for any infringements of rights of other parties, which may result
from its use.

This document could include technical or typographical errors. Changes are periodically made
to the information herein; these changes may be incorporated in new editions of the
publication. This manual is provided solely and exclusively for educational use and this
information or related products should not be used nor relied upon for any purpose except for
education and training.

Technical Support

Please contact your local TLL authorized product representative for questions regarding
hardware, software or applications issues. Any updates or patches will be sent to you
automatically as long as your registration is current. The TLL products are designed to be
supported remotely by allowing viewing of the user’s desktop. It is highly recommended that
the PC from which you are using TLL products is connected to an Internet link that allows Web
browser access. In this way our technical support staff can view your desktop and work with
you to understand and solve technical issues
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Chapter 1

Prerequisites

System Requirements

The following are the prerequisites for a computer to run the required software tools for doing

basic digital designs on theTLL5000. Make sure that these components and minimum hardware are
present.

Personal Computer: Pentium 1 GHz or higher -- Although lower processors will run the software
tools, the desired results are not guaranteed.

512MB RAM — for average applications, larger designs a 1GB RAM or greater is useful.

Minimum 5-GB on Hard Disk — The Webpack ISE requires around 3.5 GB for all its components.
DVD Drive

SVGA Monitor with the resolution of 1024x768 -- Monitor resolutions has been kept at
1024x768, which is ideal.

Windows 2000 or XP operating system with ServicePack-4 (for Windows 2000) & ServicePack-2
(for WinXP)

Three USB2.0 ports

One RS232 serial port

Ethernet Network Interface Card (NIC) The network interface card should have been configured
on your system. Make sure that you have configured the network card with a static IP address.

Software requirements

The following software needs to be installed in the PC used for connecting to the TLL5000 Base

Module.

Xilinx Webpack ISE 9.x/ 10.x (our limited experience is that the Xilinx ISE version 8.x should
also work, but we recommend that you use version 9.x). If you are using the previous versions
of ISE, please update with the service packs for getting the drivers for the Xilinx Programming
Cable. This tool is provided with, ISE simulator, XST synthesizer, PAR and downloads (iMPACT)
applications.

ModelSim-XE — the Simulation software for behavioral simulation. One should also be able to do
these exercises using the full ModelSim software from Mentor Graphics but there will be
differences in methods and commands that this manual does not address.

Hardware requirements

e The following items are required to start using the system.

e TLL5000 Base Module.

e Power supply for TLL5000 (18volts / 3.5 Amps)

e USB cables — 2 Nos.

¢ Xilinx Platform Programming Cable — newer versions use an USB interface, but parallel cables
will also work.

e CDs with, User Documentations and Software.
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The CDs provided with the TLL5000 will typically contain the following items. Please consult
with your local TLL product partner for specific details as your configuration may be different from

this table.

DVD Directory Description Remarks
Various application utilities and Please check with your local
TLL User Software : bp TLL partner to verify that the
1 associated software and hardware
and Manuals manuals and software are the
manuals for the TLL5000. .
most current versions.
As a convenience for the user, this | These tools will have a license
CD has the freely downloadable duration determined by Xilinx
Web downloadable L . .
2 software tools FPGA software from the Xilinx and they will provide updates
Website. The registration is done through their standard update
online by the user. mechanisms.

Notel: The installation of Xilinx tools are self guided. Click on the Setup.exe in the directory and
the installation starts.

Note2: Choose the option of cable drivers during the installation of Webpack ISE. If these drivers
are not chosen then the drivers for Platform cable — USB will not be installed in the System.
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Chapter 2
Setting up TLL5000 Base Module

The following picture shows the connections to be made between the PC and TLL5000 Base
Module. Please strictly follow the steps as per the manual to avoid any problems to the hardware.
The wrong sequence of applying power and connection sequence can cause damage to the system.

Power Supply
(18v / 3.5A)

Power ON/
OFF Switch Power

(CON100)
/ USB port for TLL5000
Connection

(CONS01)

USB Cablel

itll P | e BXiIinx Cable2
gl b il i s ;

FPGA JTAG port JTAG port
(CON1) (From PC to TLL5000
14-pin CON1)

Figure 2-1
TLL5000 platform setup.
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Power ON and TLL5000 Configuration
usmg System Controller

Connect the power supply to the power supply connector — CON100.

e Connect the USB cablel between PC-USB port & CON801. This connection is used for
communication and configuration of the TLL5000 from the PC using the TLL software
provided with your system.

e Switch ON the power supply on the TLL5000 with POWER ON/OFF Switch.

e As the power is switched ON, the LEDs near the power connector will turn ON.

e Now use the TLL5000 Hardware Manager utility (typically included as a menu selection in
the TLL Design Center software, please consult your local TLL partner for specific directions)
to configure. This will bring up the following screen on the monitor.

B TLLS000 - Monitor/Controler = | )5
et et et
BoadID | e st IR e ) et |
Elherret | [ElRF ] e [P T Mot Dare
Address | =2 INET ket

= Haten el ies G

- _._LJv'i_ |—'IVflJ ’jv | ,« h-l-fu:-.lf || 0000000 t"‘ e req [O=00000000 irr;
L d Y (L A e 108 R TLR]S EA, &l Rannnnan 00000000
Pt I AT S I A T ) I fil==l il J‘“' : fizzid
[Ecrtral
SFSEN 2 s =2 EHE D egisters
B — . 1l lﬂ il
ekl [0 MHz ||| SeeneE [ | == ] J I 8 | r“n._
@ oz | 100.0000 | FAH: l— | [P hEse | [H | # |J - EED
. el Tiesting e ALEEINHE egsters
Pl . ) — — & a
ekt L0 e | | eeeetan [ | [EeRe ] x| T [ e e
= Gz 100, 0000 = l— WEt [ et B J )= | f5] |J 00 [Fead I
CloaibE :
PR I e R e [ g e [T DUty Enele EHegelifee vy L
docessary For Clle 10 | 1000000 bMHz  [Divider Bypassad L” Iivider Bvpassed ﬂ [ j i St I
sppassary Fort G2 [ 1000000 MHz  [Divider Bypassed) || | Divider Bypassad | = | ol |
LPERL Herzenine & | 1000000 MHz  [Divider Bypassed) ||| Divider Bypassed o = il |
L/PECL Mezzenine B [ 100.0000MHz  [Divider Bypassed) || Divider Bypassed o = c e o |
= (B a0 -
SIS S
WEzZEnTE B I 100L0000 MHz  [Divider Bypaszed Jl Divides Bupaszed j I I j 3 I 0 = ae _I
fMezzzime & | 10000000 MHz  [Divider Bypassed ;I Jivider Bvpasszed 'j [ 'j o r 'l e I
FRGES | 1000000 pMHz  [Divider Bypassed LI ider Bupassed j [ j N SE I
AL | 33,3333 MHz  (Divider 3) =l 3% Ho=1 e=2 =[]0 =] & 2|
Status mformation (Eorfigusice fie

Figure 2-2
Hardware Manager.
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1. Click on the Choose device option in the step-5 screen, options will be displayed as shown
below:

i TLL500D - Moniator/ Controles

LL-5000 Develapment Board
Chooze Device

and
Tl L

ELHErAEEE]

Figure 2-3
Selection of target platform.

In the options above we shall see “TLL5000 Development Board”. This option will be enabled only
by connecting USB cable between TLL5000 base module and PC.
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2. Now click on the “TLL5000 Development Board” option in Step-6. The following screen
appears on PC.

Ef TLL5000 - Monitor/Controler E =

[Rfrerme yjest

Connected BnadIDl ' Power NP 195 eS80 3 Tiest

| LL-5000 Develapment Board =] s
e

[ON] BozdlP [ 192 .168. 0 . 0 HatDions

e = e [ e R s ——————————— ' = I L B P

e | L e - ) Heagd laar]
2% e S AT (A el =i ol T A S sl P II:,;I[ 00000 = E:‘ req | 0000000 S Fi
B Tl e e gy I T 1 1EEY 1 BT iz O white - ) bl e
_ - 5 |D=00000000 Head sl | 000000000 Fead |

v |[Il]." [ HA LI

o

= e e o
Al Tiesting Al DFEnEEE
s ok ety & Ee=d

cickl [0 HH EEETE T I_ 33 | st | | Ii | s £ it
o~ [mike & m HH= I s | [ |'r.'->r.'.| Fy] 1= J| I-I:'-"- Hesd

H

e A 5 i 14
[ EERL: Al R el T Rl Dty Eele Pliase ifset (3 [
SpcessarEart Lk J 1000000 BHz  [Divider Bypaszed LI [ivider Bypassed j 1] j CF =
toessary Port Ek 2 J 10000000 BHz  [Divider Bypassed LI Divider Bypassed ﬂ 1] j [ ) SEl
| M sz anite ] 10000000 BHz  [Divider Bypassed L‘I Divider Bypassed j 0 j C & Cet
ISPECL Hezzanine B | 100.0000MHz  [Divider Bypassed) =] | Divider Bypassad o = Sl R T
[V E e [
(TG 5
HEz2Emie B J 10000000 BHz  [Divider Bypassed LI Divider Bupazzed d [ d ' "o [ o L=
'-1=.?.':--'-I*==.=~.~'3.] 10000000 BHz  [Divider Bypassed LI Divider Bypassed ﬂ | ﬂ o i e o et
.-'—'I-.<'~.J 1000000 BHz  [Divider Bypassed L‘ Divider Bypassed d I j C & et
(SR J 333333 MHz  [Divides 3) ;‘I 3% HC=1 LC=2 j i j P o ]
Stafuz infprmation Eanfiguratanmiiie———
Board Powered Diown { Fead | e
Figure 2-4

Checking platform status.

e At this stage the screen displays the status as “Board Powered Down” (see the Status
information marked in blue in the above screen). This means the platform is not powered
up. Once the “Power ON” button is clicked then the platform will get powered up.

e The power supplies for the various TLL5000 elements (FPGA, memories, peripherals, etc)
are started by clicking on POWER (marked in the red color) in the above screen. Now the
power supply is enabled for all the parts of the board and the screen is shown as below.
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3. The above screen provides monitoring of the TLL5000 onboard power supplies and
configuration of the various user-settable parameters such as the system clocks shown in the lower
tables. For example, the expected voltages and the actual voltages will be displayed in the “Power
Values Monitor” section in the upper left of the display screen.

EE] TLL5000 - Monitor/Controler M=l E
Etherret Test
Cormected BoardID | o HostlP  132.163.0.3 [lexs
LL-5000 Development Board = Ethernet [OFF]
| =l A s BoardIP [ 192 788, 0 . D Mok Dions
— Power Yalues Monitor FPGA [RAM]—— —CPLD [RAw)
- I : + Read * Bead
125 12390 1400 - 1260 a3y 1zav S SR I_ ’_ 2
ssyv [asv 2900 H: oy Bav 1oy *:] , reg | 0=00000000 e Wit reg (000000000 £ \Wite
SO B : ' - [Bona00008 DWD000000D
12v [138v || naay- 120y vl izt | || _Read |
Clocks Cantral :
JTAG Tesding ADS510 Reqisters
— Clock Inputs

ki ]L— MHz | | Scan l:hainl_ Set | UumHS’v'Fl TX] IR ] reg | 000 if;::

@ oz [100.0000  MHz wat | T4 Reset | | DR || val P90 Fead
Clack Outputs
LVPECL- Dutput Frequency [Divider] Diuty Cycle Phase Offzet O i
Aecessory Fort Lk 1 | 1000000 MHz  (Divider Bypassed) 7| | Divider Bypassed Ello =l C & _ Sel
Agcessory Port Ck 2 | 1000000 MHz  (Divider Bypassed) ¥ | | Divider Bypassed Ello =l & S
L\PECL Mezzanine | 1000000 MHz  (Divider Bypassed) = || Divider Bypassed o =l C & | Sd
LWPECL Mezzanine B | 1000000 MHz  (Divider Bypassed) = || Divider Bypassed o =] v | Set
LWDS and CMOS VDS CHOS
Mezzaning B | 1000000 MHz  (Divider Bypassed) ¥ || Divider Bypassed o =ls o €& S
Mezzaning & | 100.0000 MHz  (Divider Bypaszed) ¥ || Divider Bypassed o & o & _Se
FPG& | 1000000 MHz  (Divider Bypassed) x| | Divider Bypassed o = C & | 5d
CPLD | 333333 MHz  (Divider 3] =[x He=1 -2 =0 =] & Se |
Status information Canfiguration file
[locks set 0K Read | _wite |
Figure 2-5

Platform power up.
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Setup for Xilinx Platform Cable & TLL5000 Base

Module:

Note: Before connecting the Xilinx Platform Programming Cable from the PC to the target TLL5000,
it is required to complete all the steps of TLL5000 Power ON and Configuration using the
TLL5000 Hardware Manager as explained in the above section.

e When the Xilinx Platform Programming Cable is plugged into the system, the hardware is
identified. This can be verified by right clicking on
My Computer - Properties > Hardware - Device Manager - Programming cables.

J Ackion

E;. Deyice Manager

=101 x|

sl

Wiew |J1- -P|

ENCN 1 T3
Carnputer

--D Disk. drives

@ Display adapters

--% Floppy disk, controllers
[)-42 IDE ATAFATAPT contrallers
% Imaging devices

- Kevboards

Maonitors

ﬂ}i Metwork adapkers
- 5 Ports (COM & LPT)
Ew Programming cable

-- Systemn devices

Mice and other poinking devices

/il ilinx Platform Cable USE

--{EE Sound, video and game controllers

-85 Universal Serial Bus controllers

Figure 2-6

Checking status of the platform USB cable.

e Now observe the color of the status LED on the Platform cable — USB box. It will be orange.
The status will remain orange till the other end of Platform cable — USB (a 14-pin Flat ribbon
connector) is connected to the TLL5000.

14-pin FRC connector
goes to TLL 5000 board
CON1

J

Status LED

N

Figure 2-7

Checking status checking.

This end goes to
PC USB port
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e Now connect the Xilinx Platform Programming Cable to the JTAG 14-pin FRC connector
labeled CON1 on the lower right of the TLL5000 (this is non-reversible connector with a

CON1

- B u_lr.ii;ii@_hé
E |-_-|| PP [l
- ] T |

Figure 2-8
TLL5000 platform JTAG connector.

¢ When the Xilinx Platform Programming Cable is connected to the TLL5000 the status LED of the
Platform Programming Cable will turn GREEN indicating that the JTAG communication is
successful with target board.

Note: If the TLL5000 Power ON and Configuration using the TLL5000 Hardware Manager
are not followed, then the reference voltage for JTAG will not be available on CON1 of TLL5000 and
the status LED will remain ORANGE. Until the status LED turns GREEN, the bit file cannot be
downloaded onto the target Platform.
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TLL5000 Interfaces and Peripherals

Audio In RS232 S Video Out RGB IN RGB OUT LCD

Audio Out \ \ | | / /

PS2 Key

Board

Switches

PS2 Mouse

N\

Ethernet &
uUsB

MIC In VGA S Video In NTSC / PAL In NTSC / PAL OUT LEDs

Figure 2-9
Various interfaces in TLL5000.
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Chapter 3
Digital Design using Xilinx ISE

In this section we will introduce the steps needed to create a digital design with the schematic
entry method of circuit design. Schematic entry is often a starting step in learning digital design
prior to the Hardware Description Language approach to digital design, but can also be used
concurrently with HDL approaches when a block diagram or circuit view is the most natural method
of specifying the design. Now let us start with a basic design.

1. Run the ISE application by double clicking on the shortcut icon for the ISE tool or selecting it
from your Programs menu.

Figure 3-1
Invoking Xilinx ISE.

2. When the tool is invoked the following windows will appear in the ISE tool.
S Xilinx - ISE _ [==]

File Edit Wiew Project Source Process Window Help
IDFEHG 22 ExX[@a B2 A R[[51% 8 @ ]~ w2)]oh k] =i
IEF = = | & 5% 5% 55 51

=]

No project is open

Select:
File-> Open Project

or
File->New Praject

g Sourses [ ey Snapshots | [FY) Libraries |

[

No flow available.

91 Processes |

(=] -

<] | >

Console | @ Enos | 1\ Wamings | [ TelShell | g Findin Files |

Figure 3-2
XILINX welcome screen.
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3. Now a new project has to be created. To create a new project, click on the “File” menu and
select “New Project” option.

S Xilinx - ISE
|Ei|e Edit Wiew Project Sou

Mew Project..,

Qpen Project...
Cpen Example...
Zlose Froject
Zave Project &s..,

[ Mew Chrl+1
._"" QpeEn... Ctrl+ 0

Close

E Sane Chrl+5
Save LS.,

B zave all

Erimt Presiew., .

e85 Brint.., Ctr|+F

Recent Files 3

Figure 3-3
Creating a new project.

4. When the new project option is selected the following window is seen. In this window type a
project name “buffer_sch” and specify a location. Select “Schematic” as the Top-Level Source Type.
And click “Next”.

ES New Project Wizard - Create New Project

—Enter a Mame and Location far the Praject

Fraject Mame: Fraoject Location
w IF:'\Menporul'MilinHEl‘l “baru_designz91hbuffer_sch I

—Select the Type of Top-Level Source for the Project

Top-Level Source Type:

<I ?chematic > LI

taore Info | < Black | Mext » I Cancel

Figure 3-4
Entering the project name.
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5. After these inputs the tool will go to the next window. Here select the target device and the
tools that will be used in developing the design. Then click “Next”.

E New Project Wizard - Device Properties
—Select the Device and Design Flow for the Project

Property Hame -~ =rhet -
Product Category Al P
Farnily Spartan3 P
Device »C351500 |~
Fackage FGEYTE |~
Speed -4 -
Top-Level Source Type Schematic =l
Synthesziz Toal =5T WHDLAYerilag) ;I
Sirnulator kM odelsim-+<E WHDL I
Preferred Language WHDL I
Enable Enhanced Design Summay  [W
Enable Meszage Filtering —
Dizplay Incremental Messages —

\ /

kare Info | < Back | Mewxt » I Cancel

Figure 3-5
Selecting of a device.

6. In the next window, click on “New Source” tab. In the “New Source Wizard” window give the file
name and select the input file type as schematic.

i x]

E New Source Wizard - Select Source Type = = I

f] IP [Coregen & Architecture YWizard)
Sc atic

State Diagram

Test Bench WaveFarm

User Docurment

P |%HDL Package
g WHOL Test Bench

Yerilog Module File: narme:
Werlog Test Fisture

e WHDL Madule Joutr_sch
WHOL Librarny Location:

IF:\MenporuIWilinHS'I “banu_designz31sbuffer_sch

o

W Add ta project

are Infa | < Black | Mext » I Cancel |
are Info | < Back || MHext » I Cancel I

Figure 3-6
Selecting a source type.
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7. When the “Next” button is clicked, the “New Source Wizard” summary window will be seen.
Click on “Finish” here.

E Mew Project Wizard - Cre

=101 %]

E HNew Source Wizard - Summary =) =]

| Project Mavigator will create a new zkeleton source with the following specifications: |

Add to Project: Yes

Saurce Directory: F:AMenparul=ilin=31 “baru_designs91\buffer_zch
Source Type: Schematic

Source Mame: buffer_sch.sch

¢ Back Firizh Cancel

Faore Infa I < Back I | Mext » I Cancel I

Figure 3-7
Completing the new source wizard.

8. In the next window click “Yes”, to create the new project directory.
=
i
| FProject Mavigator will create a new skeleton zource with the following specifications: |
Add to Project: Yes
Source Directary: F:\Menporul=ilin91 “baru_designs91sbuffer_sch
Source Type: Schematic
Source Name: bufer_sch.
\?) The directary
'F: 5k enporulizilingS1tbary_designs31 \buffer_sch'
does not exizt. Would you like to create it?
Mo
< Back I Finish I Cancel I
Mare Info | < Back | | Mext » I Cancel I
Figure 3-8

Confirming the project creation.
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9. Then click on “Next” in the “New Project Wizard”.

E Hew Project Wizard - Create HNew Source == 3
Create a Mew Sourc
Mew Sourse,.. |
Source File Type
1 I buffer_sch.sch Schematic Remove I

Creating a new source to add to the project iz optional. Only one new source can be created with the Mew Project “Wwizard.
Additional zources can be created and added to the project by using the "'Project-» Hew Source' command.

Exizting sources can be added on the next page.

More Info | < Back I Mext » I Cancel

Figure 3-9
Creating a project.

10. Again click on “Next” button on the “Add Existing Sources” window, since at this point of time
there are no existing source designs.

E MNew Project Wizard - Add Existing Sources

—add Existing Sources

Source File Copy to Project Add Source |

! I Remove |

Adding existing sources iz ophonal. Additional sources can be added after the project is created using the "'Froject-»4dd
Source” or "Project-»Add Copy of Source" commands.

tdare Infio | < Back | MHest > I Cancel

Figure 3-10
Adding an existing file.
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11.Click “Finish” on the “Project Summary” window, to create the project, or click “Back” to go
back and make some changes, if any.

E Mew Project Wizard - Project Summary o] =]

Froject Mavigator will create a new project with the following specifications:

Project:
Project Name:
Project Path:
Top Lewel Source Type:

buffer sch
F:4wMenporuli¥ilinxS1ibaru designs91ibuffer sch
Schematic

Dewice:
Dewvice Family: Spartani
Device: xc3s1500
Package: foge7e
Speed: -4
Synthesizs Tool: XIT (WVHDL/VWerilog)
Simulator: HModelsim-XE WHDL e
Preferred Language: YWHDL

Enhanced Design Summary: ensbled
Hezsaoe Filterino: disabled

=l

Cancel |

| . |

< Back

Figure 3-12
Viewing the project summary.

12.Once the finish button is clicked, the project is created and the design summary is also given in
the ISE tool window, as shown below. And click on the file name tab to edit the file, as shown in
the red circle on the figure.

[ES Xilinx - ISE - F:\Menporul\Xilinnd1\baru_designs91\buffer_sch\buffer_sch.ise - [Design Summary]

i, File Edit Wiew Project Source Process Window Help
IMEEgLlEBEx[=aEL2L2H XA F (A% 8 mo|[]2 %200 bl
e[ aEaxadleodr veer=slz-a) o  O0A|BS &F 2= =

;IHJ v

2 5 FPoa Desion Summary [<] BUFFER_SCH Project Status
Categories 1-Design Overview Project File: buffer_sch.ise Cunent State: New
<Al Symbols-> ﬂ [ ey Module Name: buffer_sch « Errors:
arithetic -~ 1108 Properties " *
o = [ Timing Constraints Target Device: #c351500-21g5 76 « Warmings:
bl - [ Finout Fisport Product Version: | ISE 3.1 « Updated: | Mon Apr 23 13 36:44 2007
EeeiE ﬁ! - [ Clock Report
accd E1-Enors and Warnings | BUFFER_SCH Partition Summary [
acrh = [ Synthesic Messages [ o pariion information was found |

Symbol Mame Filter - [ Translation Messages

[ Hap Messages _
Detailed R t
- [ Place and Route Messages stafled Reports
Orientation - [ Timing Messages Report Name Status Generated Errors Warnings Infos
[Fatate 0 3| [ Bitgen Messages Syrithesis Report
T | - [21 &Ml Current Messaqes || [Transistion Repart
Project Properties Map Report
=3 Sources| ey Srapshats| [ Libraries | <2 Symbols Enable Erhanced Design Summary || [ Place and Aoute Report
—— i [ Enable Message Filtering Static Timing Fleport
= [l ' O Display Incremental Messsages 9 e
No fi ilabl Enhanced Design Summary Contents Bitgen Report
o Tlow available. : Show Partition Dists
= O Show Erors
O Show wamings
[ Show Failing Constraints
i [ Show Clock Report
B Processes
i Design Summary 5] buffer_sch sch
x|  Started : "Launching Schematic Editor to edit buffer sch.sch”. -
Startced : "Launching Design Swanary'™.
<] ] »
5] Console [ @ Emors | v\ Wamings | G TolShell | g FindinFiles |
|[20,2736]

Figure 3-13
Viewing project summary in HTML format.
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13. Click on the “Float Window” button to get a better view of the schematic editor. This is the
same as an undocking feature.

1% 8 o2 w2
:.G/Dﬁﬂm

Figure 3-14
Undocking the window.

14.Once the schematic editor is undocked, i.e. the window is floated, the following window can be
observed.

B buffer_sch.sch [ 3
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il [[[l
Kl o

1432572,

Figure 3-15
Selecting the components.

In this window click on “Symbols” tab in order to get the various components under different
component categories, in the left side of the window.
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15.From the “Categories” tab in left side of the window, select “buffer” and select the desired
symbol from the “Symbols” tab and place in the editor window, as shown in the figure. The editor
can be zoomed in / out as per the requirement. Notice the grid positions as guides to drawing a
neat layout.

IH | R oed 20X X BRAn [ Has20 -5 [2-8[ N0 /[
1 x| S

T Options ESymbnlsl .
[ Select Options :
When youslick on abranch [ff - - - TR
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When you move an object
FKEEDthECDnnEC“mStD ::.'::::.'::::.'::::.'::::.'::::..../.......f::::f::
ather objects e o o T

™ Break the connections to
other objects A 0l = 1 | =

Wihenyouuse the areaselect ||| - - 00 0 o0 oo oo Dol TRURE D
tool, gelect the objects that

% pre enclosed by the area

™ |ntersect the area

‘when you uze the area zelect

Figure 3-16
Placing the components.

16. After placing the components, the wire has to be connected. To connect the wires right click in
the editor, select “Add” select “Wire”.

Frint Current Shest

FPop to Sallimg =Schemmatic
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Me =t e

Ut Lt e
L s =t
Paste L |

Faste Special. ..

) Delete oo
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. Zoom » Met Mame Strl+ 0
Select and Clear » Bus Tap el B
O bisect Properties Alt+Enter I Marker el

=Z=ymbol ZErl 41

Instance Mame el

=Y ol =]

Zircle

Line el L
Rectangle

Te=xt CErl+T

Figure 3-17
Adding wires to the components.
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17.Now as shown in the below given figure, add the wires to the components, in the editor
window.

&1
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=l
e Lee

THUF

D ..:- EI..

TBUF

= 81
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= - 1

CBUF

= - e &
— BUF

TRUF

Figure 3-18
Placing wires.

18. After adding wires to the components, the 10 markers are to be added to the wires, which
should be used for applying the inputs and monitoring the outputs. To add 10 markers again right
click in the schematic editor, select “Add” and select “1/0 Marker”.

Print Current Sheet

Pop to Calling Schermatic

Previous Wiew

Mext Yiew

Zut: Tl
Copy Chrl+ &
Paste Chrl -+

Paste Special.,.

Delete L
Zaarm L4 Met Mame
Select and Clear + Bus Tap
Object Properties Alt+Enter I/0 Marker
Syrmbaol
Figure 3-19

Adding 1I/0 marker.
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19.Place the 10 markers as shown in the figure. While placing the input marker select “Add an
input maker” and for the output marker “Add an output marker” in the options window on the left
hand side of the window.
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o TR
ffff::::::::fffffffff.@?ffffffffff::::::::fffff

Figure 3-20
Renaming I/0 markers.

20. To edit the object properties of the 10 markers, in the name field delete the existing name and
give the desired name, and click “OK”.

B object Properties il
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4| |1

Ok, I Cancel Apply | Help

Figure 3-21
Renaming the markers.
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21.Repeat the same for all the ports. Save the schematic. Next perform a “Check Schematic”
function has to be done. This same as check syntax process, in the text based design entries.

..&.maa

: :|Eheck Schemath:l: :

Figure 3-22
Checking the schematic.

22.Observe the “No error or warning is detected” message in the console window as shown below.

x|

Start DRC
Mo error or warning is detected

4] |
|£| Cansole ﬁErmr 1", Warning

Figure 3-23
Observing console window.

23. Then dock the floating window by clicking on the “Dock Window” button.

=

. -|D|:n:k Hhiz window| -

Figure 3-24
Docking the window.
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24.Then click on the “Sources” & “Process” tabs in the ISE tool window. Select the option as
“Behavioral Simulation” in the “Sources for” window.

= ~ilinx - ISE - F:AMenporul’iXilinz91\baru__designzs31\buffg
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=
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&t Presesssrea Options |
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Figure 3-25
Selecting the simulation option.
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25. By selecting the input file name in the “Sources for” window, expand the “ModelSim Simulator”
window from the “Process for” window and run the process called “Simulate Behavioral Model”.
This will invoke the simulator that we use to simulate the design. Here ModelSim XE 6.2c is the
simulator used.

lE]'Mudelsim XE ITI/Starter 6.2c - Custom Xilinx ¥ersion
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Figure 3-26

Forcing the input signals.

26. Force the selected input signals with the desired values, and click on “OK”.

EFDI‘EE Selected Signal il

Signal Marne; |sim:.-"I:uuffer_sn:h.:"l:uuffer_in'l
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* Freeze ¢ Dive  Deposit

Drelay Far: |EI
Cancel After: |

ak. | LCancel |

Figure 3-27
Docking the window.
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27.Then click on “Run” button, in order to view the simulated results.

EEIE R
| [ Fur]

—

£

Figure 3-28
Run simulation.

28. The simulated results can be seen in the wave form window. The vertical yellow bar is the
cursor. Wherever the cursor is placed, the corresponding values will be displayed in the wave
window, as marked in the below shown figure. Different inputs can be applied and the output can
be viewed accordingly. Once the satisfied output is got the simulator may be quitted.

buffer_out?
buffer_out3
buffer_out
b i

buffer_outh
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4
4
4
4
4
4
4
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Figure 3-29
Viewing the simulated output.

29. The next step in the FPGA design flow is to synthesize the design. Synthesis is the process that
generates the equivalent gate level netlist for the input design file. The netlist is a text based file
that contains the details of the devices and the interconnection network that are used in the
design.

30. In order to run the synthesize process, select “Synthesis/Implementation” option in the “Source
for” tab, and right click on the “Synthesize — XST” process, in “Process for” window and select
“Run” from the pop-up menu. Once the synthesis is completed, expand the synthesis process to
view the synthesis report, RTL Schematic & Technology view of the given design.
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31. The above processes are shown below.
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Figure 3-30
Synthesizing the design.

32.The next process is the implementation process. This process has three major steps under it.
They are (a) Translate, (b) Map and (c) Place And Route.

Translate:
Translate is the process that merges all the input files and the constraint file into a single netlist.

Map:

Map is the process that maps the logical components to the physical components. Logical
components are the ones which are there that according to the circuit diagram. And, the physical
components are the ones that are physically present inside the FPGA.

Place And Route (PAR):

The map output file will be taken as the input file for the PAR process. The map file will contain how
many CLBs & I0Bs are required to implement the design. And also it will have the details of which
are the CLBs & IOBs that are used in the design implementation. Based on that information, those
particular CLBs and 10Bs will be configured. This process is called as placing, and the routing is the
process which makes the interconnection CLBs and/or 10Bs.

33.Before going to the process of implementation, it is necessary to write the user constraints
(ucf) file. This is the file where the designer can give the constraints for the design to be
implemented.
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34.To enter an ucf file, click on “Project” menu and select “New Source” option.
EXilinx - ISE - F:AMenporul’Xiling9d1\baru_designs91\buff

L. File Edit Wiew | Project Source Process Add Tools
IEEEEINE

JJEJ = [ [ @E Add Source... abe
add Copy of Source...

Sources fu:ur:l Synthesis Zleanup Project Files

'-Léj buffer_sch Toggle Paths
=- E:E HCBSLEDD-*”QE Archive. ..
@ﬁﬁbuffer_s

Take S=napshot...
Male Enapshot Current

apply Project Properties. ..

Source Control 3

Figure 3-31
Creating a new source for constraints file.

35.0nce the new source is selected, the “New Source Wizard” window gets opened. Here, enter
the file name and select the input file type as “Implementation Constraints File” and click on
“Next”.

E Mew Source Wizard - Select Source Type M=
BhM File

‘:] |F [Coregen & Architecture Wizard]

% MEM File
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W Verilog Test Fisture

"] YHOL Module

WHDL Library

P |WHDL Package

| VHOL Test Bench

IF:'\MenpUIul\XiIinHS'I “baru_designs314buffer_sch . |

¥ Add to project

tore Infa | ¢ Back | MHext » I Cancel

Figure 3-32
Synthesizing the design.

36.When the next button is clicked, the “Associate Source” window gets opened. Here select the
appropriate entity/file name. If only one file is added to the project, then by default the same is
selected. If more than one number files are there, only then we need to select the file/entity name.
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37. Select the file (entity) name and click on “Next”.

E Mew Source Wizard - Associate Source M= E3

|Select a source with which to associate the new source,

Mare Info | < Back | Mezt » I Cancel

Figure 3-33
Selecting an associated source.

38. Then again click on the “Finish” button. If any changes are to be made, click on “Back” and
make the required changes.

E Mew Source Wizard - Summary M= E

| Froject Mavigator will create a new skeleton source with the following specifications: |

Add to Project: es

Source Directony: F:A\Menporul&ilingg1 Ybaru_designs31\buffer_sch
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Source Marme: buffer_sch.uct

Agzzociation: buffer_zch

< Back Finizh Cancel

Figure 3-34
File summary.
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39. When this is completed, the ucf file is created and added to the project. To check this click on
the + sign beside the input file name in the “Sources for” window. In this example design, the pin
constraints will be in the ucf.
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ouT4 Output a3 [BANK
41 | 4 Packaye View A Architecture Yiew f 4 | » d
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Figure 3-35

Assigning pin numbers.

40.To give the pin constraints, select the ucf file and expand the “User Constraints” in the “Process
for” window, and run the process “Assign Package Pins”. This will invoke another XILINX — built in
tool called PACE (Pinout Area Constraint Editor).

41. Enter the pin numbers, where the inputs and the outputs are supposed to be connected. The
details of these pin numbers, may be found in the user manual.

42. After entering the pin numbers, the save the file and PACE tool may be exited.

43. Then again select the design file in the “Sources for” window.
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44.The next step is to run the implementation process. So, right click on the “Implement Design”
rocess and select “Run” from the pop-up menu.
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Figure 3-36
Implementing design.

45. During the project design of a digital system each process can be found in some of the following
states

J Running — the process is in the running phase.

Up-to-date — Process is successfully executed without mistakes or warnings. If the rapport is in
this condition it means that it's up to date although it could happen that the tasks covered with this
process have mistakes and warnings.

& Warnings reported — the process is successfully executed but there are warnings.

@' Errors reported — the process is finished with at least one error.

) out-of-Date — signifies that there have been made some changes and that the process needs to
be done again.

No icon — In the case of, there is no any of these icons the process hasn't been started.
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46. After the design implementation process is complete, the programming file needs to be created
to download into the FPGA to correctly configure it. To generate the programming file, run the
rocess called “Generate Programming File” from the “Process for” window.

EXilinx - ISE - F:AMenporul'Xilink91\baru_designs91\buffer_schibul
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Figure 3-37

Generating bit file.

This process will generate the programming file. i.e., the bit stream file will be generated. This is
the file that will be downloaded onto the FPGA.

Once the file is generated, the next step is to make the communication between the host system
and the target TLL5000.
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47.Before starting this process, “Power ON” the board as given previously. To make the
communication, expand the “Generate Programming File” process and select the “Configure Device
(iMPACT) process.
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Figure 3-38

Configuring the target device.

48. Before running the process “Generate Programming File” right click on “Generate Programming
File” and select “Properties”. In the properties window, select the “start up Options” and set the
value as “JTAG Clock” in order to avoid the warning messages in the future.
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49. This opens another software tool called iIMPACT. Click on “Finish” button, in this window.
EiHPACT - Welcome to iIMPACT o] ]

—Please select an action from the list below

+ Configure devices using Boundary-Scan [ TAG)

I Automatically connect to a cable and identify Boundary-Scan chain ﬂ
= Prepare a PROM File
= Prepare a System ACE File
= Prepare a Boundany-Scan File
SWE -

= Configure devices

uzing Slave Serial mode ;I

Cancel

Figure 3-39
Checking for boundary scan devices.

50. This process detects three different devices that are present on TLL5000 target. The “xcf32p” is
the flash device, “xc9572” is the CPLD device and “xc3s1500” is the FPGA device.
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Figure 3-40
Selecting the target device.
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51. The “Assign New Configuration File” is place where the programming file will be browsed to the
location and selected, by clicking on the “Open” button. But, here DO NOT!! Select or configure the
flash device and the CPLD. So, click on the “Bypass” button to bypass these components. And
finally when the FPGA is highlighted, select the generated bit file, and click “Open”.

Ol ‘i_é 0w f A Exum | ﬂ
*cf32p wCIET2x] #c3s1500
bypass bypazss --- file ¥ ---
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Cancel &l | Bypassz |
+ MNone
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" Enable Programming of BFI Flash Device Attached ta this FPGA
i
Figure 3-41

Selecting the bit file.

52. After completing this process, the bit file will be selected for the FPGA, to be programmed.

i f i f i f
LS T N ¢ T S T (—
*cf32p e T xo3=1500
bvpass bypass bhuffer_sch bit
TDOD
Figure 3-42

Selecting the bit file.
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53. Now right click on the FPGA, and select “Program” from the pop-up menu.
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O A Exumoc f 1 £ f
; k ; k Program...
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xcf32p XCA5T2x] wcds 5l Get Device 10
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Figure 3-43

Programming the device.

54.1n the “Programming Properties” window, just click on “OK”.

E Programming Properties
Category

=R rarming Propertiss

Advanced PROM Programming Properties
i Rievision Properties

I~ Werify
—General CPLD And PROM Froperties
I" | Erase Before Programming [T | Read Protect

™| EROMYCocBunnerdl U sercode [BiHe: Digits] I

—CPLD Specific Properties
I~ wiite Fratect [T Funchional Test [T On-TheFlr Progran

I~ #PLA UES Erter up to 13 characters I

—PROM Specific Properties
T Load FRGE 7| ParalelMede [T Use D4 far CF

—FPGA Device Specific Programming Properties
I~ Pulze PROG [~ Fragram ey

— Spartan3AM Pragramming Froperti
™| Data Protect [ | Data Lockdown

aK I Cancel Apply Help

Figure 3-44
Programming the device.
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55. The program status can be observed by the viewing the “Progress Dialog” box.

1
TOl o
p

i i
E—E e
- -
xcf32p ®oES TR
hypazz bypazs

Do —— E Progress Dialog [24%] 7| x|

E xecuting command...

=c3s1:500

butfer_zch hit

....................................

Figure 3-45
Downloading

the file.

56. Once the device is program is downloaded, the “Program Succeeded” message appears.

i E i 3
s R > T S T
k| K A I
*ct32p *COST 2 xxde1s00
bypass bhypazss butter_sch hit
DD
Program Succeeded
Trograirm succeeded
Figure 3-46

Viewing statu

S message.
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Functional Test on the TLL5000

The design downloaded onto the TLL5000 is tested for correct functionality with the use of switches
and LEDs available on the target TLL5000.

TLL5000 Rev 1.1
]

copyright 2006.

Figure 3-47
Observing the outputs.

As the switches are toggled to ON/OFF positions, if the design is functioning correctly then the
corresponding output LEDs will turn ON/OFF to match the switch positions.
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Chapter 4
Digital Design Using VHDL

1. To invoke the ISE 9.1 tool, double click on the below shown icon, on your desktop.

T

silirs 15E
.11

Figure 4-1
Invoking XILINX tool.

2. Once the tool is invoked the below shown window will open.

B Xilinx - ISE _[Ofx
File Edit View Project Source Process Window Help
0P HE L]0 BX[oaR)2L%Xxm 8% 8 n ) "l 1[I

5 = @ | &5 2 % 7t

|

No project is open

Select:
File->Open Project
or

File->Mew Project

g Sources | [y Snapshats I ELibraries I

=l

No flow available.

E—t Frocesses I

=

]

&t

4 |
Conzole mErrors I LW’amings I_ﬂ Tel Shel I | Find in Files I

Figure 4-2
Tool welcome screen.

40 Copyright © 2008 The Learning Labs, Inc.



TLL5000 Electronic System Design Base Module Getting Started Guide, Ver3.4

3. To start a new project, click on “File” tab and select “New Project”. The same is shown in the
below figure 4-3.

S Xilinx - ISE

File Edit Wiew Project Source Process Window Help

New Project... % [ & e [ |JJ Jepe

Open Project... j

E

Qpen Example...

Zlose Project en
Save ErOIECE A

[ mew Ctrl+n
13’ Open... Ctrl+0

Close

E Save CHHl+5
Save 85,

& save Al

Frint Fresien. ., 5 Libraries I

Ly Brint.. Cirl+P
S|

Recent Files »

Recent Projects 3

Exit

Figure 4-3
Creating new project.

4. When “New Project” is selected a new window is opened as shown in the figure. In the “Project
Name” field enter the desired project name. Now, it can be observed that a folder is created with
the same name in the “Project Location” field. This is for keeping track of all the input & output
files in the same location.

S ilinx - ISE
File Edit Wiew Project Source Frocess Window Help

IO EF [ eEx e Rl B[Al= = @ c0lm 52100 @a]
& = 6 | & TS0 9t 91

ld

Mo project is open

§ Select: [EE New Project Wizard - Create New Project =1 <]
File->0pen Project

—Enter a Mame and Location for the Project
Proj; F Project Location

m /) IF'\menpnrul\XilinHEl‘l\lesl_prc\iec:t ,,,I

—Select the Twpe of Top-Level Source for the Praject

EE Sources | é; Snapzshots I E L Top-Level Source Type:

or
Filg->Mew Project

[HDL |
No flow available.
EI—: Frocesses I More Infa | < Bacle | Mest > I Cancel I

Figure 4-4
Entering project name.
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5. Let the “Top-Level Source Type” be as HDL itself. After giving the necessary inputs and clicking
on “Next” the next window appears. This is the place where the target hardware & necessary tools
are selected. Key in the inputs as per the requirements. Then click on “Next”.

E= Mew Project Wizard - Device Properties

l—SeIect the Dievice and Deszign Flow for the Project
FProperty Hame W alue
Product Categomn Ll
Farmily Spartan3
Dewvice =C351500
Package FGEYE
Speed -4
Top-Level Source Type HOL
Suyntheziz Tool #=5T NWHDLAYerlog)
Sirnulator ModelSim-XE VHDL fHDL
Freferred Language WwHDL
Enable Enhanced Design Summany W
Enable Meszzage Filtering i
Dizplay Incremental Meszages —

More [nfo | < Back | | Mest = I Cancel

Figure 4-5
Selecting target hardware.

Note 1: The Simulator Chosen — ModelSim—XE, Synthesis Tool — XST (this is the built-in Webpack
ISE)

Note 2: The device, Package and speed are chosen based on the details of an FPGA chip on the
TLL5000.

XC3S1500-4fg676

XC — Xilinx Component.

3S — Device Family, in this example, it is Spartan 3 Family.

1500 - Device Gate density. As per this example, 1500 kilo gates are present in this chip.
-4 — Speed Grade.

FG — Package type. Fine-pitch Ball Grid Array.

676 — Number of 1/0s on the chip.
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6. To create a new source, click on the “New Source” button.

E New Project Wizard - Create New Source = =] B3

Create a Mew Sourc
P

Mew Source... |

Source File Type

I

Creating a mew gource to add to the project iz optional. Only one new source can be created with the Mew Project Wizard,
Additional sources can be created and added to the praject by uzing the "'Praject->Mew Source' command.

Existing sources can be added on the next page.

More Info | < Back | MNext > I Cancel

Figure 4-6
Creating new source file.

7. When the “new source” button is clicked give a file name for the input source code, and select
the file type, from the left hand side list. In this example it is a VHDL module.

5 MHew Project Wizard - Cre o ] [
E Mew Source Wizard - Select Source Type m=E3

{I IP [Caregen & Architecture Wizard)
Schematic
<+ State Diagram
Teszt Bench waveForm
zer Document
Yerlog Module File name:
Werilog Test Fisture Ihuffer_S

W
i
I

WHOL Libram Location:

F|WHDL Package = -
Tl WHOL Test Bench IF:\menpruIWllln:-:E'l hhest_project . |

v &dd to project

tare [nfo < Black | M et > I Cancel |
More Info | < Back ” Mexst » I Cancel I

g

Figure 4-7
Selecting file type.
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8. After giving the file name & file type, the input and output port list of the design has to be
given. Port list is the top level entity of the design. After giving the port names the directions of
the ports can also be entered as per the design requirement. If the port is a type of bus, that can
also be entered, along with the number of bits specifying the width of the bus.

E Mew Project Wizard - Create Mew Source = | =]
E Hew Source Wizard - Define Module =1 B

E ntity Mame Ibuffel_B

Architecture Mame IB ehaviaral

Port Hame Direchion M5B L5B =
a in 7
b out 7
| in
in
in
in
in
in |—
in
in Bd

Mare Info | < Back | Mext » I Cancel |
Mare Info | < Back ” Meswt » I Cancel I

Figure 4-8
Enter the port list.

Note: The Port names to be entered in the above window shall also be 1 bit for typical logical gate
implementations. In the above design we have taken an input port of 8-bits (0O to 7) & output port
of 8-bits (0 to 7).
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9. After giving those details, click on “Next” & “Finish”.

[E5 Mew Project Wizard - Cre o ] |
E HNew Source Wizard - Summary = [T =]

| Project Mavigator will create a new skeleton sounce with the following specifications: |

Add to Project: Yes

Source Directony: F:\menporulilingg1 Stest_project
Source Type: YHDL Module

Source Mame: buffer_8 vhd

Entity Mame: buffer_8

Architecture Name: Behaviaral

Part Definitions:
a Bus: V.0 in
b Buz  T0 out

< Back | Finigh I Cancel |
Mare Infa | < Back ” Meut > I Cancel I

Figure 4-9
File summary.

10. After clicking on Next, the tool will ask for the confirmation of creating a new folder. Simply
“Yes” can be clicked. This will create a folder named as the project name, in the specified location.
And based on the information that is given, a skeleton of the VHDL file is created which will have
all the declaration parts of the file. This is common for all the VHDL files.

[Z2 New Project Wizard - Creats uice = =]
_{ol ]

| Project Mavigator will create a new skeleton zource with the following specifications: |

Add to Project: Yes
Source Directory; F:\menporulsilingS1 \test_project
Source Type: VHOL Module

Souce Name: buffer_B.vhd
Entity M ame: buffer_8 P The directom
Architechure Name: Behavioral \:()
Fort D efinitions: 'F:hmenporuliiingg1 \test_project’
a Bus: 7.0
b Busz 70 does not exist. Would you like to create it?

< Back | Firish I Cancel |
Mare Info | ¢ Back | | Mext > I Cancel I

Figure 4-10
Creating project directory.
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11. Click on “Next” in this window.

E Mew Project Wizard - Create Mew Source

Create a Mew Source

[ew Source. . |

Remove |

Saurce File Type
1 butfer_8 whd WHOL Module

Creating a new zource to add to the project i optional. Only one new zource can be created with the New Project ‘wizard.
Additional sources can be created and added to the project by uzing the "Project->Mew Source’ command.

Esisting sources can be added on the next page.

tore Info | ¢ Back | MNewt » I Cancel

Figure 4-11
Creating new source.

12.Since a new project is being created, it is not required to add any existing source at this point
of time. So, click on “Next”.

E Hew Project Wizard - Add Existing Sources

—Add Eristing Sources

Source File Copy to Project Add Source |

1
Hemave |

Adding existing sources is optional. Additional sources can be added after the project is created uzing the "Project-»Add
Source' ar "Project-+Add Copy of Source” commands.

Mare Info | < Back | MHest = I Cancel

Figure 4-12
Adding existing file (if any).
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13. The summary is created based on the information that is given so far. Now click on “Finish”.

E New Project Wizard - Project Summary M=

Project Mavigator will create a new project with the following specifications:

Project:
Project Name: test_project
Project Path: F:ihimenporuliXilinx91htest_project

|»

Top Lewvel Source Type: HDL

Device:
Device Family: Spartani
Device: xe3s1500
Package: fge76
Speed: -4

Svynthesis Tool: 3T (VHDL/Verilod)
Simulator: Modelsim-3E VHDL
Preferred Lancuage: WHDL

Enhanced Design Suwmary: chnabled
Message Filtering: disabled LI

< Back | Finizh I Cancel |

Figure 4-13
Viewing project summary.

14. Figure 4-14 shows the VHDL file for, the given design. Normally, whenever the file is generated
it will contain the library declaration, port declaration & architecture declaration. Only the
functionality of the design has to be entered by the designer. This simplifies the job of the designer
and time is also saved.

Exilinx - ISE - F:AmenporuliXxilinx91\test_projectitest_project.ise - [buffer_8 vhd]

[4] File Edit Wiew Project Source Process Window Help . = g
IR R IE A s e Y A == P2 =2
e[ B Rodlc == =2]+% %% O x|
= 15 -- Revision: =

Sources for:lSynthesis/lmplemenlation ;I le -- Revision 0.01 - File Created

H B - 1tiona orrments:

= egp—— 17 nddit 1c *

55 €7 351 0000676 12 -

- [l buffer_3 - Behavioral (buffer_8.vhd) 20 | library IEEE;

21 use IEEE.STD_LOGIC_1164.ALL:
22 use IEEE.STD LOGIC ARITH.ALL:
23 use IEEE.STD_LOGIC_UMSIGHED.ALL:

BG
25 ———— Uncomment the following library declaration if instanciating
2B ———— any Xilinx priwitiwves in this code.
aw ——library UNISIM:
G Sources | {2y Snapshats I [T Libraries I 28 --use UNISIN.VComponents.all:
z9
| 30 encity buffer § is
Processes for: buffer_8 - Behaviorsl 31 Fort ( & ¢ in STD_LOGIC_VECTOR (7 downco 0) 2
T 3z b : out STD_LOGIC VECTOR (7 downto O)):

[ AddExisting Source
- Create Mew Source
-5 Wiew Design Summary
g Design Utiities

g User Constraints

B2 Senthesize -®ST

-F2  Implement Design

33 end buffer_8;

archicecture Behavioral of buffer § i=

-T2  Generate Pragramming File

end Behavioral;

4l | i .
< | o
E—t Processes I
buffer_8.whd | i, Design Summary |
= Grarced : "Launching ISE Text Edicor to edit buffer S.vhd"”. ;I
Started : "Launching Design Summary™.

-

(| | [
] Console | @ Enars | o\ Warings | [ETcl Shell | g Fird in Fies |

[Tn 41 Cal 1R [ PAPE TNHM SRR VHDI

Figure 4-14
Tool generated VHDL file.
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In the above window the IEEE libraries are included by default, the design b_<= a; is entered by
the user. This code will act as a buffer where the value of a is loaded to b (all the 8-bits).

15.As per the design flow, after design entry the 1% step is to simulate. So to simulate, the
simulation option has to be selected. The steps for selecting it, is shown in figure 4-15.

Behavioral Simulation of the Design

16. When the design is ready, choose the Behavioral Simulation option (This option is available on
our top left hand corner of your ISE — near Sources for)

Exilinx - I15E - F:A\menporulXilinz31%teszt_projecthtest_project.ise -
E File Edit Wwiew Project Source Process wWwindow Help

IMEEE LD EX @ H]2 2%
e & o [ BRI D|cr | = =
=|

15 —— Rew

Sources for: | Synthesiz/mplementation LI 16 —— Rew

. - - 17  —-- add

'.fé'-j test_| Senthesis/lmplementation iE L
2 £78 wels avioral Simulation 1o __.
: Fost-Tranzlate Simulation e Librar
Fozt-tMap Simulation

Post-Foute Simulation 21 use IE

=2 use IE

=23 use IE
P

25 ———— 1

26 ———— &

27 ——1likbr

B Sources I [laat) Snapshots I |E Libraries I 28 ——use
29

=| 30 entity

Processzes for: buffer_8 - Behavioral g; Po:

= Add Existing Source 23 end b
= Create Mew Source 54

= “iew Design Summary 35 archit:
‘% Dresign Utilities 36

+-3F  User Constraints 37 beoin

Figure 4-15
Selecting simulate operation.
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17.Then select the VHDL file in the source for window and run the “Simulate Behavioral Model
Function”. To run any process, select the appropriate process and press enter or double click the
process or right click on the process and select run option from the pop up menu.

EXilinx - ISE - F:\menporul'Xilinx91\test_projectitest_project.ize - [buffe

m Fil= Edit Wiew Project Source Process Window Help

IDFEA LIS EX @a|Hl2oXK XA

g @6 (@A X D[] =52
x|

15 —— Revision

Saurces for: | Behavioral Simulation =l 16 —- Rewvision
: - 17 —— Addition
':"5':] tesl_project e

Bl €23 #c351500-41g576 I
e [ua] buiffer_8 - Behavioral [buffer_8.vhd] 20 library IEE

21 use IEEE.ST
Z2 use IEEE.ST
23 use IEEE.=ST

24
25 ———-— TUncormm
Z6 ——== any Xi
27 ——library U
B Sources | 51 Shapshots I |E Libraries I 28 —-use UNISI
29
= 30 entity buff
Processes for: buffer_8 - Behaviaral I 93 pore |
H - 32
[ AddExisting Source a9 end buffer
[ Create Mew Source 34 -
-3 ModelSim Simulatar 35  architectur
B ¥ Simulate Behavioral Model X
e |
Rerun
Ef Rerun Al
Er(t Stop lFic

Qpen Without Updating

E‘—t Pracesses | - —
':E,'i: Properties... De:

Figure 4-16
Simulating the design.
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18. The simulator used here is ModelSim-XE from Xilinx. Once the process is started, the simulator
tool is invoked. The simulator main window and the wave window are opened. As, shown in the
below figure.

Iﬁfh’ludelﬁim SE PLUS 5.8¢c
File Edit Wiew Compile Simulate Tools Window Help
|eBR | |SagH|| 4 E oxdlEE B e
Workspace x|
o It Tizgi it | Desi ith # Reading F:/Menporul/FPGADEILS PS Modelech ol fvsim/pref kel
Jis — | = | — | /¢ MadelSim SE 5,85 Mar 01 2004
)] buffer_8 buffer_8[be... Architecture /7
B std_logic_unsigned std_logic_un... Package # 4/ Copyright Model Technology, & Mentor Graphics Corparation company, 2004
I o i) &l Rights Reserved,
Bl <1d_loge_arth stdIogie_aith Package ) UNPUBLISHED, LICENSED SOFTWARE.
B std logic 1164 st logic_1... Packags #//  CONFIDENTIAL AND PROPRIETARY INFORMATION WHICH IS THE
B standad standard Package #/¢  PROPERTY OF MENTOR GRAPHICS CORPORATION OR ITS LICENSORS.
it
tt do {buffer_8 fda}
#* Wwarning: [vlib-34] Library already exists at "work”,
# Model Technalogy ModelSim SE woom 5 8c Compiler 2004.03 Mar 25 2004
# - Loading package standard
# - Loading package std_logic_1164
# - Loading package std_logic_arith
# - Loading package std_logic_unsigned
# - Compiling entity buffer_8
# - Compiling architecture behavioral of buffer 8
# i -fib work. -t 1ps buffer_8
# Loading F:Wenporl\ FPGADVEILSPS Wodektechiwain32).. /otd standand
# Loading F:\Menporul\FPGADVEILSPS Wadetech'wind2/ . fieee. std_logic_1164[bady)
# Loading F:Wenporl\ FPGADVEILSPS Wodektechiwind2y.. fieee. std_logic_arith(body]
# Loading F:\Menporul\FPGADVEILSPS WModeltech'wind2/ . fieee. std_logic_unsigned(bo
# Loading wark, buffer_8{behavioral]
# wave
wave - default
ile Edit Wiew Insert Format Tools Window
[zRS || sBaf|| kX ||[Nalqa ek
Shiffer_ Juuuaoou ...
i [ O N[ H{W{HYUTNTHTN 1
Librany | sirm | Files 4 |« |
- Opstolns
|Nuw: 100 ps Delta: 0 |5|m:fhuﬁer_8 | i |
Figure 4-17

Compiling and simulating.
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19. Now maximize the wave window and right click on the input signal and select “Force” from the
Oop-up menu.

File Edit Wiew Insert Format Tools Window

|EB8|| s BRA| LAY R e Q] ARk |FIHUHE

Ahuffer_G/a LI 0
Jhuffer & (biject Declaration 0

Wiew Azzertion

Radix
Format

Cut
Copy
Paste
Delete

Irzert Divider
Inzent Break paint

F|:||'|_. £,

MaoFarce
Clock...

Properties...

Now 100ps ] 500 1ns 1500 2rs 2500
Curzar 1 Ops
1 []4] [l -0

| 0 ps to 2860 ps |

/|

Figure 4-18
Selecting Force option.
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20.When in the “Force Selected Signal” enter the desired value for the input signal(s) and click
‘LOK!!-
-18]x]

File Edit Wiew Insert Format Tools  Window
Jwéj,}emjwujmm@@mwﬂ;g

Foice Selected Signal

Signal Mame: lsim:.-’buffer_Sf’a

alue: 01010101

Kind

% Freeze Diive © Deposit

Delay For: |0
Cancel After

ok Lancel

1500
Cursor 1

4] I+ IR I
[0 ne ta 2860 ps ‘

ST

Figure 4-19
Forcing the input signals.

21. After forcing the input signal, click on the run button. The shortcut to the run button is encircled
in red color in the below shown figure.

=t wave - default
File Edit “iew Insert Format Tools indow

EEMMJ = (i

/buffer_B/a Luaaauoun ...
douffer_ B840 [LDDULILL

Figure 4-20
Run simulation.
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22.0nce the simulation is run the output for the given input can be observed in the wave window.
This is known as functional simulation in which only the software code is simulated prior to the
design being implemented directly on the hardware.

=+ wave - default
File Edit Wiew Insert Format Tools  Window

RS s@ma|| kXl || xa) @& @R || ELEE

|:|urE-r i ||1||1||1||1 Juugguuy 103010101

f AP ERRER s o L0107

Figure 4-21
Viewing the simulated waveform.

Synthesis of the Design

23. The next step after simulation is to synthesize the design. Synthesis is the process which will
generate the gate level netlist of the design. In order to run the synthesis process the selection has
to be changed as “Synthesis/Implementation” in the sources for window. This netlist output file will
be the input file for the implementation process.

E Xilinx - ISE - F:\menporulXilinx91\test_projectitest project.is

m File Edit Wiew Project Source Process Window Help
IEEEIEE @@xlmallm-wd
HDMU[@%%%%IH@@IM EEE

15 -- Re
16 -— BRe
17 -— Aic
15 -
. Post-Tranzlate Simulation ;E 1_.___
ibrs=

Past-tap Simulation

Post-Faoute Simulation 21 Al

22 use 1
23 use 1
4

25 -
Z6 —-———=
7 --1ik
ETS Sources | 1 Shapshats I IDLibraries I 28 --use
z9

| 30 entit
3l 13

3z
] and ¥

Frocesses for: buffer_8 - Behavioral I
D Add Ewxisting Source

Figure 4-22
Selecting synthesis option.

The progress of the Synthesis process will be shown in the console of the ISE (Left-down corner).
In case of any errors, the details of the errors will be displayed. With any type of error, the design
will not proceed to the Implementation stage. The synthesis generates the synthesis report, RTL
schematic, Technology Schematics. The user should verify these reports in order to understand the
actual logical circuitry that will be configured in the FPGA.
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Implementation of the Design

24.The implementation process has three different sub-processes in it. They are Translate, Map,
and the third is Place & Route.

Translate:
This is the process that merges all the input files and the constraint file into a single netlist.

Map:

The process of mapping the logical components to the physical components is known as Map.
Logical components are nothing but the components that we have as per the design circuit
diagram. Physical components are the components that are there inside FPGA such as LUTSs,

gates, flip-flops.

Place And Route:
This is the process of configuring the appropriate CLBs & I10Bs inside the FPGA and

interconnecting them. Also known as, PAR.

25.To do the implementation process, the constraints file has to be given as another input file. To
create a new user constraint file (ucf), click on project from the ISE software and select new
source. Once that is completed the window shown below appears. Select implementation constraint
file and give the desired file in the file name field. Then click on “Next”, “Next” and “Finish”.

E Hew Source Wizard - Select Source Type M=

[ ) EMM File

] |F [Coregen & Architecture YWizard]
"t MEH File
Ir| Schematic
I
% State Diagram
| Test Bench "W aveFam II:uuffer 5
Idzer Document =
Y | Yerlog Module
iargul_ghluezz:zmure IF:'xmenpu:uruI"-XiIin:-:E'I hhest_project _I
WHOL Librany

| P]WHDL Package
U] WHOL Test Bench

Implementation Constraints File

File name:

L ocation;

v &dd to project

tdore Info | < Back Mext » Cance|

Figure 4-23
Applying input constraints.
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26.The above process will create an ucf file and automatically add it to the project. By selecting
the ucf file in sources for window, “Run” “Assign Package Pins” process from Processes for window.
The details of the pin locations are for switches and LEDs available on TLL5000 board.

EXilinx - I5E - F:AmenporulXilink91\test_projectitest_project ize - [buffer

[w] File Edit Wiew Project Source Process Window Help

IEEEEIEIEEEEE A E =Y

6 & @ [ BEHEAAR DNy [— =2 =2,
|

15 —— Rewision

Sources for: I SynthesizAmplementation LI 16 - Rewvision

: - 17 —— Addition:
'-"E'-j tezt_project 18 __

El- £ #c3s1500-4FgE7E 19

El- ;ﬁ; buffer_8 - Behawioral [buffer_8.vhd] Z0 likrary IEEI]

b [Peg] butfer_8.uck [buffer_B.ucf) 21 use IEEE.ZTI

22 use IEEE.3TI
Z3 use IEEE.3TI

211
=5 ———— Uncoron:
26 ———— anvy Xi.
27 —=libhrary I
Sources Snapzhots Libraries Z28 ——use UNISII]
=8 551 Snap
=9
= 30 entity kuffe
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Figure 4-24

Assigning package pins.
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27.0nce “Assign Package Pins” process is run another built-in tool from ISE will be opened called
Pin-out Area Constraint Editor (PACE). Enter the pin numbers in the LOC field as shown in the
figure. The pin number details in the figure below (bottom-left window labeled “Design Object List
— 1/0 Pins™) are as needed for the TLL5000 LEDs and Switches.

# Xilinx PACE - F:A\menporul\Xilinx91\test_project\buffer_8.ucf
File Edit WYiew IOBs Areas Toals Window Help
[Oza|Z - aseEningzdrepms | [RQaaap00RO00ENRI]
Design Browser =10l x|
a 140 Ping
o ([ Global Logic
- ﬂ Lagic
Taptisw
12345 6878 2100 121141567 EBAH0220H5H
& (WO O W] O CTEm] »
I 0] IO s
I ESE | | CIE I | 0 g
o g | O [ | m o
3 3
| D r F
——— . . . G o n 8
! X
h Design Object List - 170 Pins _ O] x| " EEE EEE H
1/0 Name|1/0 Direction| ~loc | Bank 170 Std. 1 EEEEEEREREEN o}
< Input % | |BANKS K AEEEEEREEEER K
acly Input v3 | [BANKE L O ENAEEEEENN | L
a2y Input {[v10 | [BANKE " [ EREEEEEEEN | M
a3y Input {111 | [BANKS N EEEEEEEEEN N
acdy Input Y12 BAMEKS P HEEEEEEEEEE F
a<hy Input W11 BaMKS R u HEEEEEEEEER [ R
a<hy Iript W12 BAMES T ] HEEEEEEREENE ] T
> Input W13 BANKS u BEEEAEEEEEEEE u
b0 Outpt ART BAMKS v |0 EEEEEEEEEEEE o v
bely Output ARS BAMES w Y W
() Output AE9 BANKS v ] = !! e . ] v
b33 Output A9 BAMKS A Y A4
bedy Output | [as10 ] [BANKS B e A
b5y Output V[aa11]  [BANKE e o O [ mE a
hefy Output AD1Z |BANKS a0 o ] mE0 ] | o e
he 7y Output w13/ BAMES e OnE 0 wi| e
= w [WOD B ] B Cm| »
T 2 3 4 5 6 7 8 @M1 121 14 1851617 @18202 2255
Figure 4-25

Applying pin numbers.

28. After entering the pin numbers in the LOC field save the file and exit the PACE tool. Then in the
“Sources for” window in ISE select the VHD file and run the “Generating Programming File”
process. This process will generate the bit file which can be downloaded onto the FPGA.
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This process will run all the other processes that are there, before the generation of the
programming file. An individual process may also be run separately.

E}Cilinx - ISE - F:imenporul'iXilinx91\test_projectitest_pro

4] File Edit Wiew Project Source Process Window H
IDEEG |l DB X @ [F)F
6 & M| LA D »

1 %] 15
Sources for: I Synthesiz/ mplementation ;I 16
'-'"5'_'] test_project 1;
=I- £ #c3s1500-4fg676 1o
=1 ["4gls-E: buffer_S - Behavioral [buffer_8.vhd] 20
- [Meg] buffer_S.ucf (buffer_S.uc) z1
22
23
=43
=25
=6
27
ES Sources iP5 Snapshots |E Libraries 25
=29
[ 30
FProcezzes for: buffer_2 - Behavioral 31
“o ™ Add Esisting Source :2
[ Create Hew Source 34
o View Design Summany 35
b % Design Utilities 36
%‘ IJzer Congtraints 37
g- Synthesize - ®5T 35
Implement Dezign 33
Generate Prograngss - =l
R
@f' Frocezzes | Ferun T
S rerun all Jfer,
x| Et =tom T
Itarted : "is DEen Wwithout Updating
%ri: Properties...
Figure 4-26

Generating bit file.
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Programming TLL5000

29. After completing “Generating Programming File” process, expand “Generating Programming
File” process tab in the “Process for” window and run “Configure Device iIMPACT” process. When
this process is executed the target board has to be connected, with the appropriate cable
connections.

Al s0 e
Proceszes for: buffer_8 - Behavioral ;I g;
#-%  Design Utilties B
% Uzer Constraints 34
B B Q@) Synthesize - 5T 35 =
-- # 2@ Implement Design 36
= B 2D Generate Programming File 37 r
OF‘IDglamming File Generation Feport 23 .
o i  Generate PROM, ACE, or JTAG File an
Y. Configue DeyigaihdbACT) .
1 e

E‘—t Processes I Rerun —
sigh

gt Rerun all =
x| Started : "La'% Stop t

srarted : "Lai Open Without Updating | .

%rt Properties. ..

Figure 4-27
Configuring the target platform.

30. Once the “Configure Device iIMPACT” process is run, the below shown below appears. In this
window, just click on “Finish”.

E IMPALT - Welcome to iIMPACT ==l B

—Please zelect an action from the list belor

+ Configure devices using Boundary-Scan [JTAG)

| Autornatically connect to a cable and identify Boundary-Scan chain ;I
= Prepare a PROM File
£~ Prepare a Spstemn ACE File
= Prepare a Boundary-Scan File
SWF ¥

= Configure devices

uzing Slave Senal mode LI

< Back Finizh Cancel

Figure 4-28
Welcome screen of iMPACT.
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31. Once the “Finish” is clicked the iMPACT tool will detect the boundary scan devices on the target
TLL5000. Here “xcf32p” is a flash prom & “xc9572” is a CPLD. These devices will NOT!! be
programmed. Click “Bypass” on the following window.

25 Xilinx - ISE - F:Amenporul\Xilin«91\test_project\test_ project.ise - || ]

i File Edit View Project Source Process Operations Qutput Eleug Wm-dow Help

IDPEHA 2] REX[ e RPLPHKXA R[AI=E DGl N0 =

EZE [ @%RaR00«» [Z2 2 annnoN|axund: (250 eW
|

L BB undary Scan
FASlaveSenal — R
oalSelectaP

I Ol Exuwe Exuwe
‘alDesktop Configuration
“EalDirect SPI Configuration iz gz
[] SustemaCE

xct3Zp *C9572x xc3s1500

- [Z] PROM File Formatter - file ? s - file ? v - file ? s

hinlal

Eﬁssign New Configuration File

Laak in: |__‘_j F-/menporul/#iline31 test_project/ j £ |‘=_“F i EE

R @. Clwark
Er[gSourcesIﬁg Snaps}'l|DL|I:rar|esJ onfigL G rgo (Bt

[ _wmsgs

File: riarne: ||
File type: | Al Design Files [* mes * exo *isc * bad) j Cancel |

Cancel Al | Bypass |

+ Hone
™ Enable Programming of SPI Flash Device Attached to this FRGA
"~ Enable Programming of BF| Flash Device Attached to this FRGA

L — : y
@tPrgcesses Canfiguration Operations |

| 3 Design Summary I buffer_8.vhd | l—_& Boundary Scan

ﬂ PROGEESS END - End Operation.
Elapsed time = 3 sec.
/4 t*% BATCH CMD : identifyMPM

| |
=| Console I_oErrors I 1\, Warnings |ETC|5|“1&" I g Find in Files

| Confiquration | Platform Cable LISE | B MHz

Figure 4-29
Detecting boundary scan devices.
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32. This window is to select the programming file for
that this can also be bypassed.

the CPLD. Since we are not going to program

EXilinx - ISE - F:A\menporuliXilinx91\test_projectitest_project.ize - [Boundary Scan]
L File Edit View Project Source Process Operations Output Debug Window Help P s e
DPEEGHEEXDaBILLR B B]% B o[ % [kl =9
l[6Ze [ BpxR 00« [Z2c2(sxnnomlaxint: 230N
x|
L 3B oundary Scan
- Ba5laveSeral — —
B et AP | i r |
i~ Desktop Configuration o | izmm izmms
- TeiDirect 5Pl Configuration e e
2] SystemiCE - —
--.[Z)PROM Fite Fomatter [ES Assign New Configuration File EE
OO .
L ook ir: I = F-/menporuliling31 /test_project/ j - £ |58 5
@. C waik
D_ngo [:I wst
B Sourcesl 5 Snapskl E Libraries‘ Configuration M _msgs
T File: name: I
File type: | All Design Fies [* jed * isc * hid) | Cancel |
Cancel Al | Bypass |
&+ None
" Enable Programming of SPI Flash Device Attached to this FPGA
" Enable Programming of BFI Flash Device Attached to this FPGA
4
I E'—I:F‘rocesses Configuration Operations —
3 Design Summary I buffer_Bvhd | 5% Boundary Scan
| PROGRESS END - End Operation. ﬂ
Elapsed time = 3 sec.
/i **% BATCH CHMD : identifyMPHM i
4 | 2
£| Console LoEnols I 1\, Warnings I_ﬂTcISheII I 194 Findin Files
| Configuration | Platform Cable USE | 6 MHz | ushfs
Figure 4-30

Selecting programming file.
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33. The third window is for the FPGA. Please ensure that the FPGA is selected by being highlighted.

Then select the appropriate bit file and click on “Open”.

EXilinx - ISE - F:\menporul'Xilin31\test_projectitest_project.ize - [Boundary Scan]
& File Edit View Project Source Process Operations Output Debug Window Help -8 X
[DREHE B8R EX[@aBlL XX AR N%E 0E)A WK al =09
67 @ @%AEXCO«» (22 (sxnn 0N |aknnd: (250N
A
- iBoundary Scan
cpadlaveSeid M
- B electAP | i i
- D esktop Canfiguiation Tol | iznm iﬂm
- Direct 5P Canfiguratian '""'" '""'"
----@SystemAEE xcf32p - . =
""@PHDM File Formatter e file T e Ehsmgn New Configuration File 2] x|
DO .
Laok in: I — F:/menparnul 31 est_project/ j - £ |=_§_
0. [ work
D_ngo stt
B3 Sourcesl e Snapsi’l E Libraries‘ Canfiguration M = ~Hmegs
& File name; Ibuffer_S.bit
Filetype: | AllDesign Files [t bt "k “isc * bsd] Bl Cancel |
Cancel Al | Bupass |
¥ None
" Enable Programming of SPI Flash Device Attached to this FPGA
" Enatle Programming of BPI Flash Device Attached to this FPGA
v
‘ El_thceggeg Corfiguration Operations =
i Design Summary I buffer_8.vhd | 5 Boundary Scan I
x PROGREZS END - End Operation. ﬂ
Elapsed time = 3 sec.
// **t BATCH CHD : identifyMPM o
« | A
E Console LOErrors I L\.Warnings IﬂTcISheII I g Find in Files I
| Configuration | Platform Cable USB | 6 MHz | ushfs

Figure 4-31
Selecting bit file.
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34.Now it can be observed that the FPGA is selected with the given bit file.

EXilinx - I5E - F:AmenporulxXilinx91\test_projectitest_project.ise - [Boundary Scan]

L. File Edit Wiew Project Source Process Operations OQutput Debug window Help
IDFEHE B[S bX [ aaBRI2L2HXD BAI%E o)A x|l
EEEEET = e e T

Right chick device to select operations

--E:]Boundary Scan

walSlaveSernal P R
S et AP ] i ] i ] |
. . TCI ETHILINK . EXILN E. pat (L
‘BalDesktop Canfiguration ; k ] k ] |
“SolDirect SPI Canfiguration R R
- [E] systemacE %cf32p %c85724 xc351500
@ PROM File Formatter - file 7 - - file 7 buffer_8 it
TDO

B Sourcesl ] Snapsl’l 0y Libraries‘ Configuration b

Figure 4-32
Programming selection.

7. Right click on the FPGA that is “xc3s1500” and select program from the pop-up menu. Then the
below shown window appears. Click on “OK” in this window. This will download the bit file onto the
target device.

E Programming Properties B

Category

nming Properties
Advanced PROM Programming Properties
- Rievision Properties

I Yerify
—General CPLD And PROM Properti
I Erase Before Fragramming [ | Fead Frotect

I | FROMYCoolRunner| Usercode (B Hew Digits] I

—CPLD Specific Properti
™ | wwirite Pratect [© | Functional Test = Gn-TheFl Pragram

I~ =FLE WES Enter up to 13 characters I

—PROM Specific Properti
I~ Load FRGE [T FParalelode [T Use 4 for CF

—FPGA Device Specific Programming Properti
T PukePROG [T Frogram Key

—Spartandal Programming Properties
I | Data Pratest. 7| Diata Lockdown

kK I Cancel Apply Help

Figure 4-33
Viewing programming properties.
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35.0nce programming is successfully completed, the “Program Succeeded” message appears as
shown in the given figure.

AR« [Z2 2 (s n 0wz xiin(n
|

y5Scan
rial
: o R |
. . Ol A Eumae A Exumae
Configuration 1 ; i ; |
2| Configuration
LE xct32p *£9572x1 *xc31500
‘ile Formatter - file 7 - - file 7 - butfer_g kit
D

i Snapsl’l [ Libraries | Eonfiguration M

=

ions are:; |

Program Succeeded

Figure 4-34
Programming status.

Functional Test on the TLL5000

36. The design downloaded onto the TLL5000 is tested for correct functionality with the use of
switches and LEDs available on the target TLL5000.

Figure 4-35
Observing outputs.

As the switches are toggled to ON/OFF positions, if the design is functioning correctly then the
corresponding output LEDs will turn ON/OFF to match the switch positions.
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Chapter 5
Digital Design Using Verilog HDL

1. To invoke the ISE 9.1 tool, double click on the below shown icon, on your desktop.

T

silirs 15E
.11

Figure 5-1
Invoking XILINX tool.

2. Once the tool is invoked the below shown window will open.

BB Xilinx - ISE =] 3
File Edit Wiew Project Source Process ‘Window Help

IEEE IR RS A EN S EEE = 2 ) =

I @ @ [/ % 2f 9

=

No project is open

Select
File->Open Project

or
File>Mew Project

B8 Sources 15 Snapshats |E Libraries

|

No flow available.

2L Processes I

x

o
4« | 3

Console | @ Enos |y Wamings | [ TelShell | a4 Find in Files |

Figure 5-2
Tool welcome screen.

64 Copyright © 2008 The Learning Labs, Inc.



TLL5000 Electronic System Design Base Module Getting Started Guide, Ver3.4

3. To start a new project, click on “File” tab and select “New Project”. The same is shown in
the below figure 5-3.

File Edit Wiew Project Source Process Window Help

EX @ [LL

Open Project... j

Open Example... i x|

Close Project en

Sawe Project As..,

[ mew Ctrl+n
B’ Cpen... Ctrl+0

Close

A save Ctrlt+S
Save A5,

& save all

Frint Fresien,, . 5 Libraries I

\ e Bririt.. Chrl 4P
E

Recent Files 3

Recent Projects 3

Exit

Figure 5-3
Creating new project.

4. When “New Project” is selected a new window is opened as shown in the figure. In the
“Project Name” field enter the desired project name. Now, it can be observed that a folder is
created with the same name in the “Project Location” field. This is for keeping track of all
the input & output files in the same location.

Edit View Project Source Process Window Help

PEHE L RREX e Qi LM XS (AT B MO A KPP g [ kod daa >l 9
CE & #STR PR T

Sources =

No project is open

Select:

File-s D Proiect ES Mew Project Wizard - Create Mew Project

BT Fraiect Enter a Mame and Location for the Praject
Froject Hame: Froject Location
Full_adder | [E-ILINAAS amplehfunE sampleshFull_adder | [3

Select the Tupe of Top-Level Source for the Project
13 Sources | pgy Snapshots|| [P Librari] i e !

TopLevel Source Type
Processes DL

~
No flow available.
Ef Processes
x
< Back [ Mew> | [ Cancel |
5 e — I [
= Consols | @) Erars |y wamings | @ Teisken | izg Find inFies

3 ReslPlayer: Kab Tak ... o [ o P il - IS Ja?) Td [T 10:45 AM

Figure 5-4
Entering project name.

65 Copyright © 2008 The Learning Labs, Inc.



TLL5000 Electronic System Design Base Module Getting Started Guide, Ver3.4

5. Let the “Top-Level Source Type” be as HDL itself. After giving the necessary inputs and
clicking on “Next” the next window appears. This is the place where the target hardware &
necessary tools are selected. Key in the inputs as per the requirements. Then click on

“Next”
File Edit View Project Source Process Window Help
DPEHS LidBEX B ELPHAR BB MO AR 6|t kbd daa ;@
EEEE @A
Sources x
No project is open
FiIe->DS;|:nC:::'roiect ES New Project Wizard - Device Properties
FiIe->Ne?:L Project Select the Device and Design Flow for the Project
Property Hame Walue
Product Categony Al \9
Famil_l,l Spartan3 ~
Device #C351500 v
g Sources |y Snapshots” [ Librarief Eechooy FGE?E ot
S Speed -4 v
Processes i
No flow available. Top-Level Source Tupe HOL
Synthesis Tool #5T WHDL A erilog)
Simulatar ISE Sirmulator (WHOLAferilog) b
F'_refgned Language Werilog ~
Enable Enhanced Design Summary
Enable Meszage Filtering |:|
E‘_t Processes Displa_y Incremental Messgges |
x
[ < Back “ Mext > J [ Cancel J
Figure 5-5

Selecting target hardware.

Note 1: The Simulator Chosen —ISE Simulator, Synthesis Tool — XST (this is the built-in Webpack
ISE)

Note 2: The device, Package and speed are chosen based on the details of an FPGA chip on the
TLL5000.

XC351500-41fg676

XC — Xilinx Component.

3S — Device Family, in this example, it is Spartan 3 Family.

1500 - Device Gate density. As per this example, 1500 kilo gates are present in this chip.

-4 — Speed Grade.

FG — Package type. Fine-pitch Ball Grid Array.

676 — Number of 1/0s on the chip.
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6. To create a new source, click on the “New Source” button.

ES Mew Project Wizard - Create New Source

T i S—

Figure 5-6
Creating new source file.

7. When the “new source” button is clicked give a file name for the input source code, and
select the file type, from the left hand side list. In this example it is a VERILOG HDL module.

File Edit WView Project Source Process Window Help

D ES b XRREX De RSO AHS R[S S MO, R 0 # [k de MG
PE & B 8T S S G
Sources b4

No project is open

Select: . o ;
File-> Open Project

or
File->Hew Project E 0 C SR G = PE

% IF [Coregen & Architecture Wizard)
[©] Schematic

7, State Diagram

Test Bench'WaveForm

[=] User Document
g Sources | gy Snapshots | [ Librarefl 3 RS File: narme:

[ht] Werilog T est Fisture

Processes

] WHOL Module [fuil_aciter. |
No flow available. My HDL Libran Lacation:

[£]wHDL Package :

o] WHDL T st Banch [ExoeiLiNg<S ampletfunE samples\Full_adder |

Add to project

B Processes
~ | <Back [ Mem> i[ Cancel ]
More Info [ «Back ] Mews |

[ Caneel |

Tranecript

m?

i il |
Console | @ Erers || 1\ Wathings | Tel Shal " [ Find in Filss

O TLLE000_Getting_St... B= xilin: - ISE

& untitled - Paink A £ 10:49 aM

Figure 5-7
Selecting file type.
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8. After giving the file name & file type, the input and output port list of the design has to be
given. Port list is the top level entity of the design. After giving the port names the
directions of the ports can also be entered as per the design requirement. If the port is a
type of bus, that can also be entered, along with the number of bits specifying the width of
the bus.

E Xilinx - ISE

File Edit Yiew Project Source Process ‘Window Help

NPEHG LiZREX De NiPLHXXA R (AiRE MDE LR 0 B (koo E @
IE@E SN

Sources x

No project is open

Select: e
File-> Open Project

or
File->Mew Project

Module Mame |full_adder
Port Mame | Direction Bus | MSB | LSB |
?Et.a._.i.npu.tfsw_..‘l. - ] inDUt | | . .
ENg Sources ] Snapshots"@ Librarie] dat‘?:inpu_t_:ivyg 2 it
e —————f |camy_in_sw 3 input
FProcesses sum_o.u.tput"_led_-‘i i output i il
No flow available. camy_ouled 2 a] |
fima O i
i input =
i input
i input
i input |
i input N
T |
2f Processes :
o [ < Back ]i Mext > i [ Cancel J -
Mare Info [ < Back J i Mest > ‘ [ Cancel J

Figure 5-8
Enter the port list.

Note: The Port names to be entered in the above window shall also be 1 bit for typical logical gate
implementations.
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9. After giving those details, click on “Next” & “Finish”.

S Xitinx - ISE

File Edit View Project Source Process Window Help

FDPEHA LidBRX @ ELLMHEM B[ AT S I AR O @ [bked da IR
IERHE YL

Sources x

No project is open

Select: s Dy

File-» Open Project A

or
File-»Mew Project B E gL

| Project Mavigator will create a new skelston source with the following specifications:

ENg Sources ] Snapshots" |E Librarie

Frocesses

No flow available.

@t Processes

x

[ <Back ][ Finsh | [ Concel |
L

More Info [ < Back J i Mest » H

Cancel J

Figure 5-9
File summary.
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10. After clicking on Next, the tool will ask for the confirmation of creating a new folder. Simply
“Yes” can be clicked. This will create a folder named as the project name, in the specified
location. And based on the information that is given, a skeleton of the VERILOG HDL file is
created which will have all the declaration parts of the file. This is common for all the
VERILOG HDL files.

File Edit “iew Project Source Process ‘Window Help
DPHE L dRBEX 0e RILLPHKE B (AiBE DDA M [k wl: @
EEEE BN

Sources

No project is open

x

Select:

File-5 Open Project E New Project Wizard - Create New Source

Fi|3.>N,:,:, Project S New Source Wizard- Summary.

| Project Mavigator will create a new skeleton source with the following specifications:

B3 Saurces (] Snapshots"|E Libraricg

Processes

Mo flow available.

E‘—t Processes

x | (

<Back || Finsh | [ Canes ]I

Figure 5-10a
Verilog file Summary
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E Xilinx - ISE

File Edit WYiew Project Source Process Window Help

DPET LiUREX D RILPLPHEL B (ABE MDELR M R [ bd e v|i @
FEEE LA
Sources x

No project is open

Select: R o
File->Dpen Project s
o
File-3Mew Project B % E are

| Praject Mavigatar will create a new skeleton source with the following specifications:

Add to Project: Yes o - )
‘Source Directary: EAILIMKAS ample’funE samples\Full_adder
Source Type: Yerilog Module g

Eng Sources o] Snapshots|||D Librariel, | Saurce Name: full_adder.

s tadule Mame: full_adder The directory
= Part Def_init'roi_'\s_f
No flow available. data_input_sw_] EVKILINK| SamplelfunExamplesiFul_adder
“data_input_sw_2

camy_in_sw_3 Pin
sum_output_led_1
canmy_out_led_2 Fin.

does not exist, Would vou like to create it?

-

[

w
=
o

E‘—t Processes

o [ < Back ” Finish J [ Cancel ]
|

More Info [ < Back J L Mext >

[ Cancel J

]l
Congzole oEnors || A\:\-"amings |

Transcript

Tel Shell ” [pg Find in Files B

ity untitled - Paint

Figure 5-11
Creating project directory.

11. Click on “Next” in this window.

ES New Project Wizard - Create New Source

Create a Mew Source

Mew Source.,. |
Source File Type

1 ’ﬁl"_atider:'i-‘ ;'\-'ierillmg M odule

Figure 5-12
Creating new source.
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12.Since a new project is being created, it is not required to add any existing source at this
point of time. So, click on “Next”.The summary is created based on the information that is
given so far. Now click on “Finish”.

= New Project Wizard - Project Summary

Project Mavigator will create a new project with the following specifications:

Project: -
Froject Name: Full adder :
Project Path: E:%WEILINXY 3amplehfunExamplesiFull adder
Top Lewvel Jource Type: HDL

Device:
Device Fawily: Spartand

Dewvice: ®o3=1500
Fackage: fge7o
Speed: -4

Synthesizs Tool: ST (VHDL/Weriloo)
Simulator: IIE Siwulator (VHDL/Verilod) .
Preferred Language: Verilog

Enhanced Design Sumnary: enabled

< Back ][ Finizh l ’ Cance

Figure 5-13
Viewing project summary.
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13. Figure 5-14 shows the VERILOG HDL file for, the given design. Normally, whenever the file
is generated it will contain, port declaration. Only the functionality of the design has to be
entered by the designer. This simplifies the job of the designer and time is also saved.

S Xilinx - ISE - E:AXILINXYSampleXfunExamples\Full_adderAFull_adder.ise - [full_adder.v]

File Edit Wiew Project Source Process ‘Window Help (=& ]
DPEHGF LidDEX e QiLPLPHEA B (ABE MO LN M R [kbddt i @
HRd BAAANQ S 2 B AR K
x 12 // Description: A
Sources for: | Synthesis/lmplementation v L3N
_'_'."é‘ipu" adder 14 // Dependencies:
= £ %e351500-410676 5
. full_adlder (full_adderv) - erision:
Ll s 17 // Revision 0.01 - File Created
18 // idditional Comments:
it e
IR S L O S A L O
21 module full adderidata input_sw_1, data input_sw 2, carry in sv_3, sum_output_led 1, carr
22 input data_input_sw_1;
23 input data_input_sw_Z;
I Lo 24 input carry in sw 3;
S i o
(=18 Sowces !anapshots@leranes ! 25 output Sum output led 1;
I Z6 output carry out_led 2;
| T ———T | it
: ~
TR e fuII._a.dder = 28 assign sSum output_led 1 = data input_sw_ 1 ¥ data_input_sw_2Z ¥ carry in sw_3;
"B AddExisting Source 29 assign carry out_led 2 = (data input_sw_1 & data_input_sw 2 |
[ Creats New Source 30 (data_input_sw_1 & carry_in sw_3) |
o Miew Design Summary 31 {data input_sw 2| & carry_in sw_3):
% Design Utiitizs = 3z
E]‘ﬁ‘ User Canstraints 33 endmodule
=P Surthesize -5 T 3 i ]
$ — 2 e | >
E‘—f‘ Processes | = |
—_— | full_adder.v i Desian Summary
=
Started : "Launching ISE Text Editor to edit full adder.w".
Started : "Launching Design Swumnary™.
.l | >
= £| Console | oErrors J_\W’amings | @Tclshell ﬁFind in Files
[Ln 31 Col47 [ Caps U [SCRL | verilog

@ RealPlayer: Chaaye ... f O TLLS000_ Getting, St = wiline: - ISE - ENEILIN,.. f % untitled - Paint Q___JE:"] 7h, [7d 11:0% am

Figure 5-14
Tool generated Verilog HDL file.
In the above code the functionality for Sum and Cary out are written.

14.As per the design flow, after design entry the 1% step is to simulate. So to simulate, the
simulation option has to be selected. The steps for selecting it, is shown in figure 5-15.
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Behavioral Simulation of the Design

15. When the design is ready, choose the Behavioral Simulation option (This option is available
on your top left hand corner of your ISE — near Sources for)

Exilinx - ISE - F:imenporulXilinx91\test_projectitest_project.ise -

E File Edit Wiew Project Source Process window Help
[¥]
IDxE & Ll D @xlmallluﬁﬁx
umgultﬂﬂtﬁtﬂtﬂtm@@lk > =
15 —— Rew
Sources for: | Synthesiz/lmplementation LI 15 —— Rew
< - - i7 —— Ahdd
":-—l-j test_| Synthesis/lmplementation e -
e e | B ehavioral Simulation 1o
Post-Translate Simulation T
. . 20 librar
Fozt-tap Simulation 24 TE
Post-Foute Simulation u=e
=2 use IE
=23 use IE
P
25 ———— 1
=26 ———— &
27 ——likr:
ES Sources I 121 Snapshots I [ Libraries I -] ——use
9
=l 30 entitcy
Proceszes for: buffer_8 - Behawioral 31 Fo
B - 3z
[ AddEuisting Source g end
- D Create Mew Source 34
“Wiew Design Summary 55 archit:
- g Dresign Utilities 36
- Bl User Constraints 37 beoin
Figure 5-15

Selecting simulate operation.

16. Now we will create a Test bench for testing the functionality of a full adder.
a. We will create a Test bench Waveform file.

ES New Source Wizard - Select Source Type

[ [F] BEMM File

& MEM File
| Schematic

State Diagram
| Test Bench waveForm

"] Implernentation Constraints File

I ’:[ IP [Coregen & Architecture Wizard]

=]

X]

| File name:

l [Fll_adder_thw

Location:

|E Sl LIMFAS ampleh funE samples ' Full_adder

Add to project

< Back [ MHe=t > Cancel ]

Figure 5 -16a
Create a Test bench file
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b. Click Next and ensure that you have added the file in the current project folder and also the
right Verilog file is associated with it.

E= New Source Wizard - Summary

= =]
Praject Mavigatar will create a new zkeleton source with the Following specifications:
Add to Froject: res

Source Directory: E:=ILIMMS amplehfunE samples'\WFull_adder
Source Type: Test Bench “wawveForm
Source Marme: full_adder_thwas b

Azzociation: full_adder

[ < Back ] l Finizh J [ Cancel ]

Figure 5-16b
Test bench file added to the current project directory

c. Now choose the type of clock. Since we are implementing a combinational circuit we will
choose combinational clock. The frequency is set internally.

E= Initial Timing and Clock Wizard - Initialize Timing

Assign Check Assign
Inputs Outputs Inputs

Wait To Wait To
® Check ™™ Assign -

Clack Tirming |nfarmation Clack Informatior

Inputs are azsigned at lnput Setup Time" and

. © Single Clock [datainput sw 1 V]
autputz are checked at "Output Walid Delay'”.
Rising Edge Faling Edge e ok~
Dual Edge (DDR o DET) (%) Combinatarial [or internal clock)
Clock High Time EEEI i s Combinatarial Timing [nfarmation

Figure 5-16¢
Chose the internal clock
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d. Set the inputs as shown below.

E= Xilinx - ISE - E:AXILINX\SampleMunExamples\Full_adderiFull_adder.ise - [full_adder_tbw. tbw*]
Fil= Edit Wiew Project Source Process Test Bench  Simulation  wWindow  Help =&
D EG LB RX| D FTn B MO S K2 B e [ kbd data 1
: = —
BEE ST D i » ety | E et B Il = b T [T000 - |GEE |
_ E01.0]
Sources for: | Synthesis/Implementation s End Time: . o ey 5o et e oen e san e
~ =] Ful_adder 1000 ns | | | | | | | | | | |
= £ o] 500410576 R 1 I s
[37eFs full_adder [full_adder.~] AN data_inp b ﬂ
Al carry_in 1 ,7 l;li r
30 surm_outp o
A carry_ou o
=g Sources !ﬁis.—.iapshqs;-!ﬁj Libraries |
[P
erarchy of full_adder_tbw
= i full_adder
I
X I |0 i | > @
P | Hisrarchy - full_ad i
{85 Erocssses | & Hisrarchy - ful_ad| full_adder v 3= Design Summar: | Full_adder_th, thw™
> Started : "Launching DesSign Summary ™ . -~
Started TCreating Thw f£iler™.
Compiling verilog file "E:/XILINX/Sample/funExamples/Full_ adder/full_adder.v"
Started : "Creating Thw file".
Cowpiling verilog file "E:/XILINI/Sample/TfunExsamples/Full_ adders/Tfull_adder <"
= =
< | 2
B [S] corsole | @ Enors | 8y Wamings | @ TelShell | [gg Find in Files |
[ Time: 749,86 ns
| @h Tuesoon [ urtitled - Pairt = LN Ta [ 11:12 am

Figure 5-16d
Set the inputs

e. From the Sources menu choose Behavior modeling option.

E= Xilinx - ISE - EAXILINX\SampleMunExamples\Full adderiFull adder.ise -
File Edit View Project Source Process Test Bench  Simulation indow  Help
ODPEHE S:dBRX e :8
ERE MAALLAQOi«» —2 =2

Sources for: | Synthesis/ mplementation vi End Time:
i |_{ Synthesiz/ mplementation 1000 ns |
] ian ] 7
Ho fll data_ing...
Al data_inp...
Ml carry_in...
M sum_outp...

Micamy_ou...

frem ] Wl tr ) ) B

Processes for: xc3s1500-4fgB76
[ AddExisting Source
[ Create Mew Source
% Design Utiities

Figure 5-16e
Behavior modeling
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f. Choose the appropriate file for simulating. In the process menu choose Xilinx ISE Simulator and
run the simulation.

E=S Xilinx - ISE - EAXILINXASam pleXMunExamplesiF u

Fil= Edit Miew Project Source Process Test Bench  Sim

DPFPEHS L:ixBRBX e A
B EE LT IODD >

Sources for: | Behavioral Simulation
| B Ful_adder

= £ »o3s5R0-HgETE
full_adder_tbws [full_adder_tbw.tb

Eg Sources

[P
Froceszses for: ful_adder_tbw
== Add Existing Source
= Create Mew Source
Wiew Generated Test Bench As HDL
= Add Test Bench To Project
fire ISE Sirnulator
Simulate

B Snapshots E Libraries

Figure 5-16f
Simulating the design

@ File Edt View Project Source Process Test Bench  Simulation MWindow Help

DRESF L:iNPRX e R:PAPHXE B (AT E O LN M B[ kbdde ¥|i @
iHEE MU IO« r —2 52 4% M E S @ 100w w

600

1000

x
Sources for: | Behavioral Simulatic » Now:
1= Full_adder 1000 ns
= £ »c3:1500-4fgE76 0

- [] full_adder_tbw (full_adde

< b4

i Source | g2 Snapsh | [ Librarie
|z
Hierarchy of full_adder_tbw:

+ e full_adder_thw - full_adder_..,

4

£ >4 > £
v ] full_adder.« & Design Summary
=

>
E‘—t Processes B Sim Hierarchy

>l
Q full_adder_thw tw D Simulation

Figure 5-16g
Waveform after Simulation
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Synthesis of the Design

17.The next step after simulation is to synthesize the design. Synthesis is the process which
will generate the gate level netlist of the design. In order to run the synthesis process the
selection has to be changed as “Synthesis/Implementation” in the sources for window. This
netlist output file will be the input file for the implementation process.

EE Xilinx - ISE - E:XILINXYSam pleMfunExamplesiEull_adde
File Edit View Project Source Process Test Bench  Simulation

DPEHS Qi BRRX o Qi@ E
@ E BN OO« » 2

|‘ Processes for: full_adder A-
= View Design Surnrmary ‘
®- % Design Utilties

©
A EE Rerun Al
ﬂ stop

Cpen Without Updating

[ I et T Sinulator.
L WARNING:UtilitiesC — Messace file "Simul

‘ P Gener
<
; '11: Processes

Figure 17
Selecting synthesis option.

The progress of the Synthesis process will be shown in the console of the ISE (Left-down corner).
In case of any errors, the details of the errors will be displayed. With any type of error, the design
will not proceed to the Implementation stage. The synthesis generates the synthesis report, RTL
schematic, Technology Schematics. The user should verify these reports in order to understand the
actual logical circuitry that will be configured in the FPGA.
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Implementation of the Design

18. The implementation process has three different sub-processes in it. They are Translate,
Map, and the third is Place & Route.

Translate:

This is the process that merges all the input files and the constraint file into a single netlist.
Map:

The process of mapping the logical components to the physical components is known as Map.
Logical components are nothing but the components that we have as per the design circuit
diagram. Physical components are the components that are there inside FPGA such as LUTSs,
gates, flip-flops.

Place And Route:

This is the process of configuring the appropriate CLBs & I0Bs inside the FPGA and
interconnecting them. Also known as, PAR.

19.To do the implementation process, the constraints file has to be given as another input file.
To create a new user constraint file (ucf), click on project from the ISE software and select
new source. Once that is completed the window shown below appears. Select
implementation constraint file and give the desired file in the file name field. Then click on
“Next”, “Next” and “Finish”.

(&5 New Source Wizard - Select Source Type g|§|g|

EMM File
'{J IF [Coregen & Architecture wizard)
"t MEM File
£+| Schematic
B8 Implementation Constraints Fils
State Diagram
| Test Bench 'WaveFom T

zer Document 'full:a:jﬁer |
| Wernlog Module Location:
ﬁﬁ'&iﬂig”mre EILINNS ampleAfurE sampleshFull_adder IL.]
™ WHDL Library
P |WHDL Package
| WHOL Test Bench

File name:

&dd to project

£ Back Mt = J [ Cancel

Figure 5-18
Applying input constraints.
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20. The above process will create an ucf file and automatically add it to the project. By selecting
the ucf file in sources for window, “Run” “Assign Package Pins” process from Processes for
window. The details of the pin locations are for switches and LEDs available on TLL5000
board.

ES Xilinx - ISE - E:AXIL INX\SampleVfunExamples\Full adde
i File Edit View Project Source Process Window Help
DPEHS LidBREX Do N: QL
HEH Y GHALL OO

Sources E FPGA Des

Sources fior: | Synthesis/Implementation P E Deesign Ov
(] Full_adder Su
= £ »c3s1500-4igE7E Qo
= [V full_adder (full_adder.v] Ori
B full_adder. ucf [full_adder ucf) D Fir
i . . a Cle
: = Errors and
E"lz Sources | g Snapshots | [y Libraries Ay
| Processes O
Processes for: full_adderuct [ Me
[ Add Esisling Souce [P
[ Create New Source i Qi
= ﬁ' User Congtraints P-roject-Prupert
&l Create Timing Constraints M Enabl
B Assion Package Pis EH:i

] Create hrea.Constraﬂs b

i @ Edit Constramnts [Text] gt sl

Figure 5-19
Assigning package pins.

21.0nce “Assign Package Pins” process is run another built-in tool from ISE will be opened
called Pin-out Area Constraint Editor (PACE). Enter the pin numbers in the LOC field as
shown in the figure. The pin number details in the figure below (bottom-left window labeled
“Design Object List — I/0 Pins™) are as needed for the TLL5000 LEDs and Switches.
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38 Xilinx PACE - EAXILINX\SampleMunExamplesiFull_adderiMull_adder. ucf

File Edit View IOBs Areas Tools Window Help

D@ & &L BRI Rdnmpme] | Zaagq R |O0C0RNC

#5140 Fing
11 Global Logic

i E Logic

& Design Object List - If0 Pins

[Unknown |

Figure 5-20
Applying pin numbers.

22. After entering the pin numbers in the LOC field save the file and exit the PACE tool. Then in
the “Sources for” window in ISE select the V file and run the “Generating Programming File”
process. This process will generate the bit file which can be downloaded onto the FPGA.
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This process will run all the other processes that are there, before the generation of the
programming file. An individual process may also be run separately.

ES Xilinx - ISE - EAXILINXASam pleMunExamplesk
File Edit “iew Projeck Source Process Window He
D PHE LD BX wa [
= (5 MU DD e =

e

Sources for: ! Syntheziz/lmplementation
= Full_adder
= £ we3s1500-4fgE7E

#- [27 e full_adder [full_adder.«]

Eg Sources | e Snapshots || ELibrarieS

Proceszes for: full_adder
I | Add E xisting Source
=l Create Mew Source
o “Wiews Design Summmarny
7S Design Utilities
ﬁ' Uszer Constraints
Pt Sunthesize - =%5T
rotslem Eresigr—

. | 21 Rerun All
| Iﬂ:‘: Processes E’(t Stap

Open YWithouk Updating

Fatal Error. C l-:i‘rf Froperties. ..

Figure 5-21
Generating bit file.
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Programming TLL5000

23. After completing “Generating Programming File” process, expand “Generating Programming
File” process tab in the “Process for” window and run “Configure Device iMPACT” process.
When this process is executed the target board has to be connected, with the appropriate
cable connections.

=l 30 .
Processes for: buffer_8 - Behavioral ;I 31
: 32
w3 Design Utiities 23 e
‘% |Jser Canstraints 34
B f}os_l,lnthesize -WST 35 =
-- P D Implement Desian 36
= P A Generate Programming File 3Tk
" rograrmming File Generation Report
E@F File: R gg .
1;@ Generate PROM, ACE, ar JTAG File
=T 40
N g

€
@I: Processes I Rerun —
i

B Rrerun Al
2l ztarted : "La'Et Stop

started : "Lal Open Without Updating | N

B Properties...

Figure 5-22
Configuring the target platform.

24.0nce the “Configure Device iIMPACT” process is run, the below shown below appears. In this
window, just click on “Finish”.

E IMPALCT - Welcome to iIMPACT == E

—Please zelect an action from the list belor

&+ Configure devices using Boundary-S can [ TAG)

I Automnatically connect to a cable and identify Boundary-Scan chain LI
™ Prepare a PROM File
" Prepare a System ACE File
£~ Prepare a Boundany-Scan File
SWF >

= Configure devices

using Slave Serial mode =

< Back Cancel

Figure 5-23
Welcome screen of iMPACT.

83 Copyright © 2008 The Learning Labs, Inc.



TLL5000 Electronic System Design Base Module Getting Started Guide, Ver3.4

25.0nce the “Finish” is clicked the IMPACT tool will detect the boundary scan devices on the
target TLL5000. Here “xcf32p” is a flash prom & “xc9572” is a CPLD. These devices will
NOT!! be programmed. Click “Bypass” on the following window.

?E';x_i_l_im- - ISE - EAXILINX\Sample\funExamples\Full_adder\Full_adder.ise - [Boundary Scan]
4. File Edit “iew Project Source Process Operations Output Debug  Window  Help

DPEHD L YBRREX e RQIPLHNM BI[N:iRE MDA, W D i [bked d
FEE UL mxnn {3 20 2N
x

Sources
- FEBoundary Scan
S ERSlaveSenial
- BESelectMAR | ! |
‘BalDesktop Canfiguration o | Ei:mlnr Exjse
- agllirect 5P| Configuration S S
- [£]8ystemaCE xcf32p %3572 *6351500
i @ FROM File Formatter e file ? - e file 7 - A e
TDO
= Assign New Configuration File
Look in: |2 E:AHILINX/S ample/funE samples/Full_adder/ v| 4=k s
1 M | .
|Et[3 Sources "m Snapsl’il |E Libraries |':'2'r'lflEl'-JrEIt [ I (S izim.tmp_save
Processes _@_ngn SES
|5 _rmsgs
File name: | | Open |
File type: | All Dezign Files [*.meos * exo “izc ".bad) vl
Cancel All I [ Bypaszs J
— ; (& Mone 45
| El_t Processes | Configuration Operations
. ") Enable Programming af SP| Flash Device Attached ta this FPGA
» '1': Putting device in ISP () Enable Programming of BPI Flash Device Attached ta thiz FPGA it
Maximun TCE operating freg
Walddat+r"dner ~haadwn

Figure 5-24
Detecting boundary scan devices.
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26.This window is to select the programming file for the CPLD. Since we are not going to
program that this can also be bypassed.

B Xilinx - ISE - EXILINX\Sample\funExamples\Full_adder\Full_adder.ise - [Boundary Scan]
i File Edit Wiew Project Source Process Operations Output Debug Window Help
DPEHS LiSDEX BDe RiPLHXS B (AR E DDA 0 # kbl I
A E BUAAL QOO XNt HBO 9N
Sources x
- BalBoundary Scan
- BalSlaveSernial
BTG electAP |
i--::]Desktop Canfiguration i, | EXi0g EXi0g
- BEDirect SPI Configuration S S
- [Elsystemace xctizp *e3572x *c3s1500
- [E] PROM Fils Formatter bypass —-- il 7 - wee il 7 e
TDD
B Assign New Configuration File
!E@Sources ||w8naps}'|!|ELibraries lConfigurationM Loak in: | 23 E:/XILINX/S ampledfunE wamples/Ful_adder/ v| 4= 5
Processes x B . PB isim.tmp_séve
[
(5 _wmsgs
e |
File type: | All Design Files [* jed “isc * bsd) v
Cancel Al ] [ Bypazs ]
| E‘—‘:F‘rocesses ! Configuration O perations | | ¥ Design ® e
»® "1': Putting device in ISP mode...done. () Enable Programming of SPI Flash Device Attached ta this FPGA B
Maximum TCE operating freguency for thil () Enable Programming of BPI Flash Device Attached to this FPGA
Validating chain...
Frnmdsro_aran chain sralidared anccsaafi] o

Figure 5-25
Selecting programming file.
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27.The third window is for the FPGA. Please ensure that the FPGA is selected by being
highlighted. Then select the appropriate bit file and click on “Open”.

3 File Edit Wisw Projeck Source Process Operations Output  Debug  Wwincows Help

E;Dﬁaa e i R B3 o@D S B @[5B B3 M Ch i~ R 0 B6 [t kbd dats

el N e, %‘#---.ﬁ= a3 0| | 2
S
 EZBoundam Scan
- BESlaveSerial

L EESclectaP I E| E g E

- E=E|Desktop Configuration el g’:""'""g 1 g £

== Direct SPI Configuration I

7 [=] SystemaCE =of32p xo957 2l cZs1S00

- [E]1PROM File Formatter brypoes Bypaes o el
TOo

= Assign Mew Configuration File

Look in: |5 E:/2<ILIMN/S amplefurE zamples /Full_adder’ | - e ==
I T M -
| =g Sources || e Snapst | [P Libraries |Configuration b | o £ isim.tmp_save
Processes > 2 _nge o st
[E=EEUNE=CI (=) (il odderbit
Fils mame: [full_adder. bit | Open
File type: | All Design Files [.hit ~.rbt = nky ~isc =bsd) ~| Cancel
[_ Cancel &1 ] [ Bupass ]
¢ & Mone
| 2f Processes Configuration Dperations
¢ Enable Programming of SPI Flash Device Attached to this FPGa,
> 1': Putting dewvice in ISP mod > Enable Programming of BPI Flash Dewvice Attached to this FPGa,
Hax ironam TCE operac ing frecuenc

Figure 5-26
Selecting bit file.

28. Now it can be observed that the FPGA is selected with the given bit file.

I Xitim - ISE - EXILINX\SampleSfunExamples\Full_adderiFull_adder.ise - [Boundary Scan] = ||
L File Edt View Project Source Process Operations Qutput Debug SWindow Help [=JE X
‘DPHA L KBREX Do R AAXXA RN BRETDI AN Mhbim v Q
;s@@'@ GRALA Q0! %‘%::::ﬁ 2E0 N
i +;:]Boundary Sean
- aveSeig g g
- EaSekecthAP
P Desktap Corfiguration TD' Dk Dt Yerfy
¥ Direct SPI Configuration AT, b (et Desice 10
- [2]systemact el 22y o357 wcdstsl et Device Sgnature/Usercods
 []PROM Fil Famat | e -
@ feramate bypess byesss fl e fissiqn New Confiquration Fle..,
00 .
Figure 5-27

Programming selection.
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Right click on the FPGA that is “xc3s1500” and select program from the pop-up menu. Then the

below shown window appears. Click on “OK” in this window. This will download the bit file onto the
target device.

,_"T.. Programming Properties

mming Properties
: vanced PROM Programming Properties
- Hevigion Properties

Figure 5-28
Viewing programming properties.
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29.0nce programming is successfully completed, the “Program Succeeded” message appears
as shown in the given figure.

EE Xilinx - ISE - EAXILINX\SampleMunExamples\Full_adderMFull_adder.ise - [Boundary Scan]
i File Edit View Project Source Process Operations Output Debug ‘Window Help
DPHD D YDEX 9@ D PAXAD B[N BB M S0 E[bddn v Q
B E @A QO @R NN 3 &30 F W
>
[ FaIEoundary Scan
- EBSlaveSerial P e
- EESelectMAP i i
‘BADesktop Configuration 1ol E e 1 E L
- galDirect S| Configuration
[E]5pstemiCE xct3zp %9572 XC351500
@PHDM File Formatter bypass hypass full_accer bit
T,
Eng Sources m Snaps}'ig |E Libraries IEnnliguratinn b |
Available Operations are: ~
= Program
e erify
= Get Device 1D PI‘ 4 =
ogram Succeeded
= Get Device Signature/Usercode gl
= Check [doode E
—h O A, rn ek b
| Configuration Operations | |
[ Sreee— il A O % Design Summary | & Boundary Scan |

Figure 5-34
Programming status.
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Functional Test on the TLL5000

30. The design downloaded onto the TLL5000 is tested for correct functionality with the use of
switches and LEDs available on the target TLL5000.

= MICROMNAS

Carry_output_led_2

Sum_output_led_1

Data_input_sw_1

Data_input_sw_2

!

Carry_in_sw_3

Figure 5-35
Observing outputs.

As the switches are toggled to ON/OFF positions, if the design is functioning correctly then the
corresponding output LEDs will indicate the Sum and Carry bits.

*END>*

89 Copyright © 2008 The Learning Labs, Inc.



	                  COPYRIGHT NOTICE
	Chapter 1
	System Requirements
	Software requirements
	Hardware requirements

	Chapter 2
	Power ON and TLL5000 Configuration using System Controller
	Setup for Xilinx Platform Cable & TLL5000 Base Module:
	TLL5000 Interfaces and Peripherals

	Chapter 3
	Functional Test on the TLL5000

	Chapter 4
	Behavioral Simulation of the Design
	Synthesis of the Design
	Implementation of the Design
	Programming TLL5000
	Functional Test on the TLL5000

	Chapter 5
	Behavioral Simulation of the Design
	Synthesis of the Design
	Implementation of the Design
	Programming TLL5000
	Functional Test on the TLL5000


